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Sissejuhatus 

Eesmärgiga omandada haritud inimese oskusi oma mõtteid nii sõnas kui ka kirjas loogiliselt 

ja korrektselt ning ladusalt väljendada,  koostavad  õppurid õppekavade raames hulganisti 

kirjalikke töid. See protsess aitab kinnistada õpitavat materjali, parandab kirjutamisoskuse 

kaudu lugemisoskust ja arendab mõtlemisoskust ning võimaldab rakendada saadud teoreetilisi 

teadmisi praktikas ja arendada uurimistöö kogemusi.  

Kuigi kirjalikud tööd erinevad mahu, temaatika ning erialale või ainele omase sõnavara ja 

stiili poolest, tuleb kõik kirjalikud tööd koostada ja vormistada ühtsete nõuete põhjal. Osa 

vorminõuetest on üldised, kohustuslikud kõikidele kirjalikele töödele, osa aga tulenevad töö 

eripärast (köitmise viis, tiitellehe vajadus, viitamise kord jm). Haridusasutused on pidanud 

vajalikuks nõuete täitmise tagamiseks koostada asjakohaseid juhendeid. 

Käesolevas Võrumaa Kutsehariduskeskuse direktori käskkirjaga kinnitatud metoodilises 

juhendis sisalduvate tööde koostamise ja vormistamise nõuete igakülgne järgimine võimaldab 

eelkõige ühelt poolt ühtlustada õpetajate käsitlusi koostavate kirjatöödega seonduvates 

küsimustes  ning  teiselt poolt annab lähtepunktid õppurite juhendamisel ja suunamisel.  

Peatähelepanu juhendmaterjalis on lõputöö koostamisel ja vormistamisel, kuid samas  

kehtivad nõuded ka ühe õppeaine raames koostatava kirjaliku töö kohta.  

Juhendi koostamisel võeti lisaks rahvusvahelistele ISO standarditele aluseks mitmete kutse-

õppeasutuste ja kõrgkoolide nõuded ja soovitused.  

Metoodiline juhend  on kättesaadav veebipõhiselt kooli koduleheküljelt ja paberkandjal kooli 

raamatukogust. 
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1. Kirjalikud tööd 

1.1. Kirjalike tööde liigid 

Iga õppur koostab õppekava  vältel teatava hulga kirjalikke dokumente järgmistel ees-

märkidel:  

� saada kogemusi erialase kirjanduse leidmiseks ja sellega töötamiseks, 

� omandada eriala terminoloogia ja korralik kirjalik väljendusoskus,  

� kinnistada ja laiendada erialaseid teoreetilisi teadmisi ja praktilise töö kogemusi, 

� arendada iseseisva uurimistöö harjumusi, 

� õppida kirjalikku tööd korrektselt vormistama, 

� hinnata õppurite ettevalmistust iseseisvaks uurimistööks tänapäevaste nõuete  

kontekstis. 

Võrumaa Kutsehariduskeskuses õppurite poolt koostatavad  kirjaliku tööd võib liigitada 

vastavalt nende sisule ja mahtudele järgnevalt:  

� õpetaja juhendamisel koostatav lõputöö;  

� õppeaine(te) raames koostatav koostatav kirjalik koduülesanne, essee, referaat, 

  ainetöö, kursusetöö või -projekt, praktikaaruanne vms.  

Mõningates õppekavades on kasutusele võetud õpimapid, mis sisaldavad lisaks õppuri 

iseseisvatele kirjalikele töödele ka muid õppeprotsessi toetavaid materjale. Õpimappide 

koostamist ja kaitsmist käsitleb osa 1.3. 

Rakenduskõrgharidusõppe lõputöö tulenevalt õppekavade ja kõrgharidusstandardi 

nõuetest peab olema iseseisvalt koostatud ning andmete analüüsi sisaldav uurimuslik või 

praktilise suunitlusega töö või projekt, mis sisaldab erialaga seotud probleemi analüüsi, 

ülesande püstituse ja lahenduse. 

Kutseõppe lõputöö koostamine ja kaitsmine võib olla  ühtlasi eriala lõpueksamiks.  

Lõputöös käsitlemisele kuuluvad teemad on fikseeritud õppekavas. 

Kursusetöö on ühe õppeaine raames juhendaja suunamisel tehtav iseseisev töö. See võib olla 

teoreetilise probleemi käsitlus või praktilise probleemi lahendus. Kursusetöö on mahukam 

kirjalik kodutöö, mis haarab mitut omavahel seotud või üht kompleksset õppeainet. Teema 

määratlemise alused kehtestab õpetaja, kes juhendab töö koostamist.  
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Kursuseprojekt on õpetaja suunamisel mingi õppeaine raames antav teoreetilise või 

praktilise probleemi lahendus. 

 Ainetöö on ühe aine teatud küsimuse lühiuuring, milles kasutatakse erialast kirjandust ja 

statistilisi andmeid, tehakse järeldusi ning leitakse suunad probleemi lahendamiseks või 

edasiseks uurimiseks. Ainetöö mahu määratleb õpetaja.  

Praktika aruanne koostatakse vastavalt iga õppetooli praktikajuhendile.  

Referaat on mingi probleemi või teema kirjandusallikate põhjal koostatav kokkuvõtlik 

ülevaade, milles esitatakse ja võrreldakse eri autorite seisukohti. Referaadi eesmärk on 

süvendada õppurite oskust töötada erialakirjandusega ning arendada väljendusoskust. Nõutav 

on järelduste tegemine ja oma arvamuse esitamine. Teemavaliku printsiibid ja töö maht 

kehtestatakse õpetaja poolt lähtuvalt õppeaine sisust. Referaadi koostamise ja vormistamise 

nõudeid käsitleb käesoleva juhendi järgmine osa 1.2. 

Essee on lühike vabas vormis üldarusaadav kirjandusliku või teadusliku sisuga kirjutis, kus 

käsitletakse mingit probleemi või nähtust isikupäraselt. Essee teema oleneb õppeainest, selle 

määrab õpetaja või valib õppur ning koostamisel pole kohustuslik  kirjanduse kasutamine ja 

sellele viitamine. Olulised on loov mõtlemine ja oma arvamuse esitamine. Essee puhul 

hinnatakse tavaliselt loomingulisust. Selle vormi-  ja esitamisnõuded kehtestab õpetaja.  

Kirjalik koduülesanne võib mahult olla ühest kuni mitme leheküljeni ning selle vormi-sisu 

ja esitamisnõuded kehtestab õpetaja.  

1.2. Referaatide koostamine ja vormistamine 

Referaadi teema tuleneb õppeainest ja see tuleb kooskõlastada õpetajaga.  Referaadi 

koostamise soovituslik järjekord on järgmine: 

1. Andmete ja materjali kogumine: 

� infoallikate otsimine (õpikud, teosed, artiklid, interneti materjalid jm), 

� lugemine, märkmete tegemine,  

� andmete või faktide kogumine. 

2. Hangitud materjali hindamine: 

� andmete ja väljakirjutuste sobivuse analüüs, 

� sobimatu materjali kärpimine, 
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� täiendava materjali kogumine. 

3. Materjali korrastamine: 

� loogilisse järjekorda paigutamine, 

� analüüs, tõlgendamine, 

� tulemuste väljatoomine või järelduste tegemine. 

4. Töö vormistamine: 

� kirjutamine, 

� korrektuur, 

� kontrollimine.  

Kirjandusallikate arvu määrab õpetaja, tavaliselt on neid 3-4 ning täiendavate allikate arv pole 

piiratud. Refereerida võib ka ühe autori teost vastavalt ettenähtud teemale. Sellisel juhul on 

tavaliselt põhiallikaks võõrkeelne uudne materjal, mida täiendatakse muude allikatega 

(õpikud, interneti materjalid jm). Andmete või faktide hankimise allikateks võivad olla trüki- 

või elektroonne meedia, käsiraamatud, statistilised ülevaated jne. 

Referaatidele omase kirjeldava analüüsi puhul käsitletakse kasutatavas allikas toodud fakte 

või näiteid mõtteseoses teooriate või teoreetiliste seisukohtadega. Uudse kirjandusliku 

materjali puhul tuuakse välja, mille poolest see täiendab koolis omandatut või läheb sellest 

lahku. 

Väljakirjutused refereeritavast allikast peavad olema täpsed. Kindlasti tuleb üles märkida 

teose leheküljenumbrid. Märkmed võivad olla refereeringud (ümbersõnastatud selgitus) või 

tsitaadid ehk otselaenud. Refereering peab säilitama allikas toodud mõtte. Refereeringu puhul 

tuleb viidata allikale ja eraldada see oma kommentaaridest. Tsitaati kasutada juhul kui 

� allikas on väga prestiižne või tähelepanuväärne, 

� sõnastus peab jääma muutumatuks (näiteks intervjuude väljavõtted), 

� soovitakse edasi anda erilist stiili. 

Tsitaadid peab eraldama jutumärkidega. 

Referaadis tuleb korrektselt viidata kasutatud allikatele. Enamlevinud viitamisel tuuakse 

ümarsulgudes autori perekonnanimi, väljaande aasta ja lehekülje number, näiteks (Tamm 

2006: 13) või (Tamm 2006, lk 13). Viitamist käsitleb põhjalikumalt juhendi osa 3.2. 
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Referaat vormistatakse vastavalt juhendi kolmandas osas toodud nõuetele.  

Referaadid köidetakse kiirköitjasse järgmiselt: 

1. Tiitelleht 

2. Sisukord  

3. Sissejuhatus 

4. Töö põhiosa 

5. Kokkuvõte 

6. Viidatud allikad (autorite perekonnanimede tähestikulises järjekorras) 

7. Lisad (kui need esinevad).  

Tiitellehele kantakse kooli nimetus (Võrumaa Kutsehariduskeskus), eriala õppetool või 

täiskasvanute koolituskeskus, autori ees- ja perekonnanimi, õpperühm, töö pealkiri 

(suurtähtedega suures kirjas), töö liik (referaat), töö juhendaja ees- ja perekonnanimi, töö 

valmimise koht (Väimela) ja aasta (vt lisa 1). 

1.3. Õpimapp 

Õpimapp ehk portfoolio on õppuri poolt õppeajal väärtustatud ja mappi paigaldatud kirjalike 

materjalide süstematiseeritud kogu, mis tõendab õppija iseseisvat ja praktilist tegevust 

õppekava järgsel õppimisel ja iseseisvaks kutsealaseks tegevuseks valmistumisel. Mapp 

vormistatakse paberkandjale ja/või elektroonilisele andmekandjale (CD-ROM, DVD või 

veebileht). Õpimapi võib õpetaja loal koostada ja esitada rühmatööna.  

Õpimapi koostamine toimub õppeaja jooksul regulaarselt õpimappi materjalide kogumise ja 

süstematiseerimisega. Õpimappi kogutakse valikuliselt:  

� õppuri iseseisvad kirjalikud tööd, kavandid, analüüsid jms või nende 

kokkuvõtted/väljavõtted;  

� õppija iseseisvate tööde näidised (fotod, joonised, skeemid jms);  

Kui töös ei viidata allikatele või seda tehakse puudulikult, on tegemist 

loomingulise varguse ehk plagiaadiga - teise autori idee või kogu töö 

esitatakse enda omana.  
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� õppega seonduvaid asjakohased tekstid ja muud materjalid, mis täiendavad või toetavad 

õpiprotsessi;  

� sündmuste kirjeldused, arvamused, hinnangud, probleemid ja nende võimalikud 

lahendused; 

� oma tegevuste analüüs; 

� skeemid, tabelid, joonised, tööde näidised; 

� vaatlustulemused; 

� muud materjalid, mis seonduvad õpiprotsessiga ja iseloomustavad õppija kutsealast 

arengut/suutlikust.  

Lõpliku valiku õpimappi kogutavatest materjalidest teeb õppur. Õpetajatel ja juhendajatel on 

õpimappi materjalide kogumisel ja valikul konsulteeriv roll.  

Õpimapi materjalide süstematiseerimise käigus liigendab õppur materjale ja viitab neile nii, et 

õpimapi lugeja saaks tervikülevaate õpimapist ning leiaks viidete abil huvipakkuvad 

materjalid.  

Õppetöö lõpus täiendatakse õpimappi, lisades sellele tiitellehe, sisukorra, sissejuhatuse, 

kokkuvõtte ning esitatakse kontrollimiseks. Sissejuhatuses näidatakse õpimapi koostamise 

konkreetne eesmärk, informatsiooni kogumise põhimõtted, allikad ja viisid ning ise-

loomustatakse mapi ülesehitust. Rühmatöö puhul tuuakse ära ka rühma liikmete vaheline 

tööjaotus. Et mapi sisu oleks ülevaatlikum, peab vormistama sisukorra, kus on näidatud ka 

leheküljenumbrid. Kokkuvõte esitatakse lühendatult (kuni 3 lk). Kokkuvõte sisaldab õppur 

kutsealast valmisolekut tõendavaid hinnanguid või analüüse õpimappi kogutud materjalidele 

sh nende rakenduslikele aspektidele.  

Õpimappi pole soovitav rangelt reglementeerida ja nii piirata õppija loovuse ja 

mõtlemisvõime avaldumist.  

Paberkandjale vormistatav õpimapi materjal paigutatakse registraatorisse. Ainult elektroo-

nilisel andmekandjal esitatud õpimapp peab olema hästi loetav. Mittelugejasõbraliku õpimapi 

võib lükata tagasi.  

Õpimapi hindamise alused kehtestab iga ainekursuse puhul õpetaja. 
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1.4. Lõputööd 

 

 

 

Tulemused peavad andma vastuse, kas töös püstitatud eesmärk saavutati. Järeldused ja 

ettepanekud peavad tulenema tööst enesest. Töö kokkuvõttes tuleb märkida, milline on 

tulemuste kasutusvaldkond. Tihti tekib töö teostamisel ka uusi lahendamist nõudvaid 

probleeme, mis tuleks töös ära märkida, et nendega tulevikus edasi tegelda. Töös ilmnevad 

kogu õppeperioodil omandatud teoreetilised teadmised ja oma seisukohtade põhjendamis- 

ning esitamisoskus. 

 

 

 

Rakenduskõrgharidusõppe lõputöös peab kajastuma õppuri iseseisev uurimistöö, mis sisaldab 

erialaga seotud probleemi analüüsi, ülesande püstituse ja lahenduse.  Töö sisulise osa orien-

teeruvaks mahuks  on minimaalselt 30 lehekülge, millele lisanduvad viidatud allikate loetelu, 

vajadusel lisad ja resümee. Kasutatavate allikate minimaalne arv on 12, neist vähemalt kolm 

võõrkeelset. 

Kutseõppe lõputöö põhineb valdavalt organisatsiooni andmetel, iseseisva uurimistöö osa on 

väiksem. Kasutada võib organisatsioonis läbiviidud uuringute andmeid, mida õppur tõlgendab 

vastavalt oma töö teemale. Töö maht  on minimaalselt 20, millele lisanduvad viidatud allikate 

loetelu, vajadusel lisad ja resümee. Lisadeks võivad olla nii organisatsiooni tegevust 

kajastavad algmaterjalid kui ka õppuri koostatud mahukad tabelid. 

Kasutatavate allikate minimaalne arv on kutseõppe lõputöö puhul kaheksa, neist vähemalt 

kaks võõrkeelset. Töös peavad ilmnema valitud teemaga seonduvad kogu õppeperioodil 

omandatud teoreetilised teadmised. Õppur peab oskama esitada ja põhjendada oma seisukohti.  

Koostatud lõputöö ja selle kaitsmine peegeldab õppuri järgmisi oskuseid:  

� pikemas kirjalikus töös konkreetse ettevõtte tegevuse ja tulevikuplaanide kirjeldamine 

ning probleemi leidmine töö koostamiseks; 

Lõputöö on õppuri individuaalne töö, mis toimub koostöös juhendajaga. 

Juhendaja roll on suunav: ta aitab teema valikul ja uuringuplaani koostamisel, 

soovitab kirjandust, jälgib töö vastavust sisulistele ja vormilistele nõuetele jne. 

Lõputöö kui rakendusliku iseloomuga pikem kirjalik töö näitab õppuri 

oskust kasutada oma teadmisi tulevase elukutsega seotud praktiliste 

probleemide lahendamisel. 
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� iseseisvalt probleemi leidmine, analüüsimine ettevõttes ja töö eesmärgi sõnastamine; 

� materjali kogumine ja üldistamine, kirjaliku tööd struktureerimine ja sõnastamine;  

� koostatud lõputööd argumenteeritult esitlemine komisjonile;  

� oma seisukohtade kaitsmine ja küsimustele vastamine. 

Lõputöödele esitatavad olulisemad nõuded on järgmised: 

 

 

 

 

 

 

 

 

 

 

 

Mida kõrgem on taotletav haridustase, seda rohkem peab töö pakkuma uut teavet. Kutseõppe 

lõputöös võib kasutada organisatsioonides läbi viidud uuringute andmeid, millest valitakse 

oma töö probleemiga seonduv. Rakenduskõrghariduse lõputöös peavad eelkõige kajastuma 

üliõpilase enda poolt läbi viidud uuringu materjalid. 

Lõputööde koostamist, vormistamist ja kaitsmist käsitlevad põhjalikult juhendi järgmised 

osad. 

� uurimisprobleem ja/või töö eesmärgid peavad olema selgelt sõnastatud; 

� eesmärgi täitmiseks tuleb valida sobivad uurimismeetodid ja empiiriline 

lähtematerjal; 

� erialakirjandus ja muu teoreetiline materjal peab olema võimalikult 

kaasaegne; 

� andmete analüüs peab olema täpne ja kontrollitav; 

� töös peab selgelt ilmnema autori omapoolne panus; 

� töös toodud väited peavad olema küllaldaselt põhjendatud ja toetuma 

tõestatud faktidele; 

� töö peab olema korrektselt vormistatud. 
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2. Lõputöö koostamine 

2.1. Lõputöö teema valik  

Lõputöö teema peab vastama õppekava sisule. Teema valikul tuleb silmas pidada:  

� oma huve ja võimeid;  

� teema aktuaalsust ja originaalsust;  

� teema ei tohi olla laialivalguv;  

� võimalust teemat järgnevates töödes edasi arendada;  

� erialakirjanduse ja -teabe kättesaadavust;  

� uurimistöö (katsetöö) tegemise võimalusi.  

Täpsemad teema valiku protseduurilised nõuded ja tähtajad kehtestab iga õppetool eraldi. 

2.2. Lõputöö kava  

Lõputööd on soovitatav alustada kava koostamisega. On kaks lähenemisviisi:  

� kirjutada välja märksõnad, mis tunduvad valitud teema raames olevat olulised ja  

huvipakkuvad. Seada nad loogilisse järjekorda ning grupeerida sisuliselt lähedased 

märksõnad alapunktideks. Töö üldkavasse saab kirjutamise ajal lisada uusi punkte ning 

välja jätta ebaolulisi või korduvaid osi;  

� koostada töö kava – peatükid ja nende alljaotised. Esialgset kava saab kohandatakse töö 

käigus vastavalt uute ideede tekkimisele või materjalide (kirjanduse, andmete vm) 

kättesaadavusele.  

2.3. Kirjanduse valik  

Töö koostamiseks vajaliku kirjanduse leidmine, läbitöötamine ja analüüsimine on õppuri 

ülesanne. Uurimistöö üks eesmärke on selle oskuse arendamine. Asjakohaseid materjale 

aitavad leida raamatukogude kataloogid, bibliograafiaväljaanded ja Internet.  

Esialgsel tutvumisel kirjandusega tuleb pöörata tähelepanu valitud teemaga seonduvate 

mõistete selgeks saamisele. Sügavamaks uurimiseks valitav kirjandus peab olema võimalikult 

mitmekülgne, haarates eri autorite erineva teadusliku tasemega kirjutisi (monograafiaid, 

artiklikogumikke, ajakirju jm). Töö ei tohi põhineda üheainsa autori kirjutistele. 

Ajakirjandusartiklitesse tuleb suhtuda ülimalt kriitiliselt.  
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Loengukonspekt ei ole kirjandusallikas. Kirjanduse valikul on soovitatav kasutada ka 

teatmeteoseid, raamatukogude uudiskirjanduskatalooge ning Internetis leiduvaid 

kirjandusallikaid. Peale raamatu sisukorra on otstarbekas jälgida ka selle lõpus asuvat 

märksõnade ning kirjanduse loetelu, mis hõlbustab teabe saamist otsitava termini või 

probleemi ning kirjanduse kohta.  

Kirjanduse põhjalikum läbitöötamine ja analüüsimine algab pärast töökava koostamist. 

Analüüsitud materjalide kohta on soovitatav koostada lühikokkuvõtted, mis sisaldavad 

uuritava probleemi kohta eriti huvipakkuvaid mõtteavaldusi, tsitaate, määratlusi, 

probleemiarendusi vms. Otstarbekas on jätta kokkuvõtete juurde ruumi ka oma mõtete jaoks 

ning sidusmaterjalidele viitamiseks. Kirjandusallikate valimisse, eriti Internetis leiduvasse, 

tuleb suhtuda kriitiliselt.  

Kõigi kasutatud kirjandus- ja muude allikate kohta on vajalik algusest peale koostada korralik 

register, milles on kirjas kõik viitamiseks vajalikud bibliograafilised andmed. See hõlbustab 

hiljem (töö vormistamisel) viitamist ja viidatud kirjanduse loetelu koostamist.  

Uurimistöö peamiste uurimisülesannete edukale lahendamisele annab hea aluse võimalikult 

täielik ülevaade antud valdkonda käsitlevast kirjandusest, nii trükis ilmunud (raamatud, 

artiklite kogumikud, erialaajakirjad) kui muud materjalid (magistri- ja doktoritööd, 

elektroonilised väljaanded ja andmebaasid). Elektroonilise koondkataloogi ESTER 

vahendusel on kasutajatele kättesaadavad kõigi Eesti suuremate raamatukogude kataloogid. 

Hulgaliselt on loodud otsivahendeid internetimaterjalide leidmiseks, näiteks Google Scholar 

[www.scholar.google.com/], NETI [www.neti.ee] jt.  

Võrumaa Kutsehariduskeskusele on juurdepääs Elton B. Stephens Company (EBSCO - 

Electronic Information for Libraries Direct) elektroonilisele teadusalaste nimestike, 

lühikokkuvõtete ja täistekstide andmebaasile (kasutajatunnus: s4079258; Password: 

password). 

Kirjandus- või muudest allikatest võetule (refereeringule või tsitaadile) peab korrektselt 

viitama, vastasel korral võidakse uurimistöö autorit süüdistada plagieerimises.  
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Tsitaate kasutatakse erandkorras, kui on vaja anda edasi täpset sõnastust. Tsitaat peab olema 

täpne koopia originaalsõnastusest. Võõrkeelne tsitaat tuleb eesti keelde tõlkida võimalikult 

täpselt  ning joone all anda ka originaalsõnastus. Tsitaat pannakse jutumärkidesse ning viide 

selle allikale peab järgnema tsitaati lõpetavatele jutumärkidele sõltumata sellest, kas tsitaat on 

lause lõpus või keskel. 

2.4. Lõputöö ülesehitus  

Lõputöö osad on tiitelleht, sisukord, sissejuhatus, põhiosa, kokkuvõte, viidatud allikate 

loetelu, lisad, resümee.  

Lõputöö, mis sisaldab nii uurimust kui ka projekti, võib koosneda kahest osast, millest üks on 

pühendatud projekteerimisele. Töö osad peavad siis olema nii sisu kui mahu poolest 

tasakaalus. Projektiosa struktuur peab vastama normide või standardiga kehtestatud nõuetele, 

ent peab olema projektorganisatsioonilt tellijale antavast täielikum ning sisaldama kõiki 

kaalutud variante ja arvutusi.  

Töö selge ülesehituse huvides on otstarbekas koostatav tekst jaotada alampeatükkideks. 

Alampeatükkideks jaotamine peab olema loogiline ning igas alampeatükis kajastub põhi-

peatükiga seotud info. Pea- ja alapeatükkide suur hulk töös jätab mulje töö killustatusest, töö 

vähene liigendatus raskendab töö sisu avamist. Vältida tuleb alampeatükkide mitmeastmelist 

alajaotamist – see killustab liigselt teksti. 

Kui alampeatükki soovitakse omakorda jaotada mitmeks alampeatükiks, tuleb analüüsida 

selle otstarbekust ning väheinformatiivsed (mõnest lausest koosnevad lõigud) pigem 

vormistada ühesse alampeatükki omaette seotud lõikudena. 

Refereering annab teise autori mõtte edasi vabas vormis, oma sõnadega, 

jutumärkidesse seda ei panda. Loetelude või pikemate refereeringute puhul tuleb 

kohe algul viidata allikale, et oleks selge – see pole autori omalooming. Kui teiste 

autorite käsitlust refereeritakse pikemalt, siis viidatakse allikale eelnevas lauses. 

Refereering ei tohi hõlmata tervet töö jaotist.  
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Sissejuhatus, kokkuvõte, kasutatud kirjandus ja võõrkeelne resümee algavad uuelt lehelt 

sarnaselt peatükkidega ning peavad olema vormistatud sama astme pealkirjadena, nagu 

peatükid, ent erinevalt peatükkidest ilma järjekorranumbrita (st. nummerdatakse ainult 

peatükke). 

 

 

 

Sissejuhatus Sissejuhatuse soovitatav maht on  5–10% töö sisulise osa (ilma lisadeta) 

mahust.   

Sissejuhatuses tuleb: 

� põhjendada teema valikut (aktuaalsus, rakendatavus jms);  

� anda lühiülevaade teema uuritusest;  

� esitada lühidalt uurimisobjekti(de) (nähtus, tegevus, organisatsioon ja selle 

tegevusvaldkond, mida uuritakse) kirjeldus; 

� määratleda töö eesmärk: milliseid probleeme soovitakse lahendada; mida peetakse 

vajalikuks uurida ja analüüsida; millised on oodatavad uurimistulemused ja milleks neid 

saab kasutada;  

� tutvustada ja põhjendada uurimismetoodikat;  

� tuua töö ülesehituse lühiiseloomustus; 

� anda ülevaade olulisematest kasutatud lähtematerjalidest ja allikatest. 

Sissejuhatuses võib autor tähelepanu juhtida nendele töö koostamisel ilmnenud asjaoludele, 

mille teadmine aitab lugejal töö sisu paremini mõista, nt empiirilise materjali esitamise ja 

hankimisega kaasnenud probleemidele ning tänada isikuid või institutsioone, kellelt saadi abi 

töö kirjutamisel. 

 

 

 

Sissejuhatus ei täida töö esimese peatüki ülesandeid ning selles ei esitata töö 

tulemusena tehtavaid järeldusi. Sissejuhatuse lõplik vormistamine toimub 

tavaliselt kõige viimasena. 

Töö ülesehitamisel tuleb vältida nii üleliigendamist (ilma iseseisva 

tähenduseta alljaotisteks jagamist) kui ka liigendamiseta kirjutamist. 

Soovitatav on piirduda kolmeastmelise liigendusega.  
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Sisuline osa  

Töö sisulises osas käsitleb õppur lahendusteid töö sissejuhatavas osas seatud eesmärkide 

saavutamiseks ja püstitatud probleemide lahendamiseks. Probleemide käsitlemisel on 

soovitatav liikuda üldisemalt (teoreetilised lähteseisukohad, metodoloogilised küsimused) 

konkreetsele analüüsile.  

Töö sisuline osa võib jagada järgmisteks alapunktideks:  

� võimalikult põhjalik, kirjandusviidetega ülevaade töö teemaga seonduvast;  

� meetodite, sooritatud katsete ja saadud andmete kirjeldus;  

� tulemused, järeldused, ettepanekud ja arutelu.  

Töö liigist, teemast ja probleemi(de)st sõltuvalt võib mõni eelnevatest osadest ära jääda või 

olla esitatud vähesemal määral. Töö konkreetne ülesehitus on unikaalsete teemade puhul 

loomeprotsess, milles osalevad nii õppur kui ka tema juhendaja. Seega ei saa järgida täpseid 

ettekirjutusi.  

Teoreetilise (kirjanduse ülevaate) ja enda kogutud andmete analüüsi vahekord sõltub 

käsitletavast teemast ja eesmärgi püstitusest. Kui uurimistöö raskuspunkt on empiirilisel 

analüüsil, tuleb esitada ka probleemi teoreetiline (lühi)käsitlus. Andmete töötlemisel peab 

kasutama statistilise andmetöötluse võtteid. Uurimistöös ei ole vaja kirjeldada üldtuntud 

uurimismeetodeid, küll aga on tarvis esitada tulemuste korrektne tõlgendus. 

 

 

See võib nt avalduda eri autorite arvamuste (teooriate) vastandamises ja võrdlemises ning 

omapoolse seisukoha ja hinnangu andmises; teoreetiliste üldistuste, järelduste või rakendus-

ettepanekute tegemises läbitöötatud materjalide põhjal, hinnangus mingi teooria või mudeli 

kasutamisvõimaluse kohta konkreetsetes tingimustes. Seejuures tuleb selgelt öelda, kellele 

hinnangulised väited kuuluvad – kas õppurile või kellelegi teisele. Probleemi lahkamisel ei 

tohi piirduda vaid ühe autori seisukohtade refereerimise, lauskriitika või ülistamisega. 

Oluline on, et igas uurimistöös sisaldub ka arutelu osa, milles soovitatakse käsitletud problee-

midele omapoolne lahendus, kus antakse üldistav hinnang või prognoos. 

 

Igas töös peab olema selgesti nähtav õppuri isiklik panus probleemi 

käsitlusse.  
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Kokkuvõte  

Kokkuvõttes, mis moodustab  5–10% töö mahust, peab selguma, kas seatud eesmärke 

õnnestus täita ning milliseid lahendusvõimalusi püstitatud probleemidele pakuti. Antakse 

vastused sissejuhatuses tõstatatud küsimustele ning näidatakse, millistele lahendus-

võimalustele ja tulemustele töö sisulises osas jõuti.  

Kokkuvõtte peamised ülesanded on:  

� anda lühiülevaade töö sisulises osas saadud peamistest tulemustest, tehtud järeldustest ja 

hinnangutest ning omapoolsetest ettepanekutest;  

� esile tuua töös tehtud järelduste ja ettepanekute kasutamise võimalused ja arendamise 

suunad ning lahendamist ootavad probleemid.  

 

 

 

Resümee 

Töö peab sisaldama võõrkeelse (inglis- või saksakeelse) lühikokkuvõtte e. resümee. Resümee 

kujutab endast sissejuhatuse ja kokkuvõtte sünteesi. Ta peab andma järgneva: 

1) töö pealkirja täpse tõlke; 

2) töö aktuaalsuse põhjenduse; 

3) püstitatud eesmärgi ja ülesannete kirjelduse; 

4) ülevaate saadud tulemustest, järeldustest, lahendustest, ettepanekutest. Seega peab 

resümee andma tööst üldistatud ja ammendava ülevaate lugejale, kes töö keelt ei valda. 

Võõrkeelse lühikokkuvõtte mahuks on ca 2/3 sissejuhatuse ja kokkuvõtte mahtude 

summast. 

Kokkuvõttes ei püstitata uusi probleeme ning ei esitata seisukohti ega järeldusi 

küsimuste kohta, mida töös ei ole käsitletud. Kokkuvõttes ei viidata ka kirjandus-

allikatele.  

 

Töö sisulise osa struktuur peab olema tasakaalus. Töö ülesehitamisel tuleb vältida 

nii üleliigendamist (ilma iseseisva tähenduseta alljaotisteks jagamist) kui ka 

liigendamiseta kirjutamist. Soovitatav on piirduda kolmeastmelise liigendusega. 

Kõige madalama tasandi alapunkti pikkus ei tohiks olla alla kahe lehekülge. 
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Viidatud allikate loetelu (osa nimetus: Viidatud allikad) koostamist käsitletakse juhendi 

jaotuses 3.2. ning lisade vormistamist jaotises 3.3. 

2.5. Töö keel 

Üliõpilas- ja õpilastööde keeleks on reeglina eesti keel. Oluline on töö keeleline ja stiililine 

korrektsus, et autoripoolne probleemide käsitlemine, põhjendused ja järeldused oleksid 

loogilised ja jälgitavad. Järgnevalt mõningad näpunäited selle saavutamiseks. 

Keelekasutus. Töö tuleb kirjutada kirjakeeles. Keelekasutus peab olema asjatundlik, 

väljenduda tuleb lihtsalt, selgelt ja täpselt. Släng, ajakirjanduslikud, populistlikud, käibe- ja 

poeetilised fraasid uurimistöösse ei sobi. Vältida tuleb emotsionaalsete omadussõnade 

tarvitamist (nt „ ... majanduslik olukord on lausa suurepärane“; „ .... hinnad tõusid maru 

kiiresti“).  

Võõrkeelsete allikate kasutamisel peab olema tähelepanelik, et võõrkeel ei hakkaks autori 

oma lauseehitust ja väljenduslaadi mõjutama. 

 

 

Võõrkeelsete terminite eestikeelseid vasteid tuleb otsida erialasõnastikest (vt 

soovitusnimistut), mitte püüda neid otsetõlkida. Üldsõnastikud (ka „Inglise-eesti tehnika-

sõnaraamat“ ja „Teaduse ja tehnika seletav sõnaraamat“), ei ole hinnanguliselt piisava 

usaldusväärsusega. Kui võõrkeelsele terminile adekvaatset eestikeelset vastet leida ei suudeta 

või kaheldakse oma valikus, on soovitav eestikeelse vastele sulgudes lisada (kaldkirjas) 

võõrkeelne termin.  

Kui töös kasutatakse suuremal hulgal vähetuntud termini, lühendi või sümboli ning igaüks 

esineb mitmel korral, siis on soovitatav  koostada kasutatavatest lühenditest ja tähistest 

loetelu, mis koosvastavate selgitustega esitatakse lisas. 

Lühendite kasutamine. Enne mis tahes lühendi kasutamist tuleb see defineerida täieliku 

kirjapildi kaudu. Näiteks: sisemajanduse koguprodukt (SKP); Rahvusvaheline 

Rekonstruktsiooni- ja Arengupank (IBRD — International Bank of Reconstruction and 

Development). Teine võimalus on esitada koondloend koos vastavate määratlustega lisas, 

millele iga lühendi korral viidatakse. Erandi moodustavad vaid üldlevinud lühendid, mille 

täisnime ei ole üldiselt tavaks pruukida (näiteks USA, ÜRO, WTO jt.).  

Võõrkeelsest allikast tuleb tõlkida lause mõtet, mitte üksikuid sõnu. 
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Kõneviis ja -vorm, milles töö kirjutatakse, peab olema ühtne kogu töö ulatuses. Autor ei 

tohiks end asetada ühe poole positsioonile. “Mina” ja “meie” vormi (näiteks “meie uurisime”, 

“ma analüüsisin”) sagedase kasutamise asemel tuleb kasutada umbisikulist vormi (näiteks 

“töös käsitletakse, analüüsitakse, uuritakse, hinnatakse” või “on käsitletud, analüüsitud jne.”) 

Eelistatav on kindla kõneviisi kasutamine, sest tingiva kõne valdav kasutamine võib jätta 

mulje, et autor ei ole oma seisukohtade õigsuses kuigi veendunud.  

Arvude esitamine tekstis. Arvud ühest kümneni on soovitatav kirjutada sõnadega, muud 

arvud numbritega (nt kaks punkti, kaheksa tööpäeva, 120 ettevõtet). Suured arvud (alates 

kuue-kohalistest) kirjutatakse sõnade ja numbrite kombinatsioonina, et oleks lihtsam lugeda 

(nt 300 miljonit). Tabelites ja joonistel võivad arvud olla esitatud ka kordsetena (nt 

tuhandetes, sadades), siis peab kindlasti lisama vastava märkuse. Suurte arvude korral, kus iga 

number on oluline, võib tuhandeid lahutada tühikutega (nt 30 450 400). Kümnendkohad 

lahutatakse eestikeelsetes töödes koma, mitte punktiga.  

Statistilises tekstis kirjutatakse kõik arvud numbritega. Arvule ei lisata käändelõppu, järgarvu 

järele pannakse punkt. Aasta tuleks märkida arvuliselt, mitte sõnadega (2005. aastal versus 

eelmisel aastal). Kui numbritega kirjutatavale arvule järgneb mõõtühik, on arvu ja mõõtühiku 

vahel sisetühik (25 kr, 43 protsenti). Arvulisi väärtusi ei tohi poolitada ega üle viia teisele 

reale. Arv ja sellele järgnev mõõtühiku tähis peavad olema samal real, mille tagab sisetühiku 

kasutamine (Crtl+Shift+tühik).  

Protsendi- ja kraadimärki ning mõõtühikute lühendeid kasutatakse ainult koos numbritena 

kirjutatud arvudega. Protsendi ja kraadi tähis kirjutatakse numbriga kokku (43%, 36°). 

Protsendi puhul on soovitav piirduda ühe, koefitsiendi puhul kuni kolme kohaga koma järel. 

Täpsed rahalised näitajad (hinnad, tariifid jm) kirjutatakse kahe kohaga pärast koma, st 

kroonides ja sentides. Kui näitaja juurdekasv on suurem kui 100%, tuleb suurenemine näidata 

tekstis mitte protsentides, vaid kordades (mitte toodangu juurdekasv oli 130%, vaid toodang 

suurenes 2,3 korda). 

Ümmargused arvud 100, 1000, 10 000 jne kirjutatakse sõnadega siis, kui arvu täpsus pole 

oluline (on ligikaudu sada töötajat). Kui täpsus on tähtis, kasutatakse numbreid (oli 100 

vastajat). Suurte arvude puhul sobivad nii sõnad kui lühendid: miljon (mln), miljard (mld) jne. 

Pealkirjades lühendeid ei kasutata. Kõikidest kasutusele võetud lühenditest tuleb 

kogu töö ulatuses kinni pidada. 
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Põhiarvud kirjutatakse araabia numbritega: 3 aastat, aastail 1999-2006. Järgarvud kirjutatakse 

araabia numbritega, mille järel on punkt, või rooma numbritega (ettevõtte 10. aastapäev, XXI 

sajand). 

Nii tekstis kui tabelites peaks loobuma rohkema kui 3–4 tüvenumbriga arvude kasutamisest 

(näiteks korrelatsioonikordaja r = 0,346, mitte r = 0,345729315). Suurte arvude korral on 

soovitatav kasutada kombineeritud kirjutusviisi, mille puhul arv on märgitud numbritega ja 

suurusjärk sõnadega, näiteks 1,42 milj. elanikku (või 211,3 tuh. krooni). 

Mõõtühikute ja nende tähiste kirjutamisel peab silmas pidama järgmist: 

1. Õpilastöödes on mõõtühikute kasutamise aluseks rahvusvaheline ühikusüsteem (SI), seega 

füüsikaliste suuruste puhul tuleb kasutada SI ühikuid ja nendega võrd-väärseid 

süsteemiväliseid ühikuid. 

2. Liitühikud on lubatud koostada SI ja süsteemiväliste ühikute kombinatsioonina. Näiteks: 

m3/h, l/s, kW·h jne. 

3. Suuruse arvväärtuse lühendamiseks tuleb algühikuid täiendada kümnendeesliidetega. 

Näiteks: megavatt (MW), megatonn (Mt), kilomeeter (km) jne. Arvväärtused peaksid jääma 

piiridesse 0,1…1000. Näiteks: 100 000 W asemel kirjutatakse 100 kW või 0,1 MW. 

4. Ei tohi kasutada mitut eesliidet järjestikku. Näiteks „millimikromeeter”. 

5. Eesliite tähis kirjutatakse järgneva ühikutähisega kokku. Näiteks: MW, pF, kJ. 

6. Korrutisena esitatavates liitühikutes tuleb ühikutähiste vahele panna korrutuspunkt. 

Näiteks: N·m, kW·h, kV·A. 

7. Jagatisena väljenduvais liitühikutes kasutatakse kaldkriipsu või astmenäitajat. Näi-teks m/s, 

A/mm2 või m·s-1, A·mm-2. 

8. Ühiku tähist ei tohi poolitada ega viia arvu järelt järgmisse ritta. 

Õigekiri.  

 

 

 

Õigekirja ning võõrsõnade ja terminite õigekirja on vaja kontrollida 

teatmeteostest. Lubamatud on mis tahes keele- ja trükivead. Autor peab ise 

oma teksti, tabeleid, valemeid, jooniseid korduvalt ja hoolikalt kontrollima. 
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Võõrsõnade ja vähekasutatavate mõistete tähendust ja õigekirja on vaja kontrollida 

“Võõrsõnade leksikoni” ja/või “Eesti keele sõnaraamatu” abil, samuti on soovitatav kasutada 

spetsiaalset eesti keele õigekirja kontrollivat tarkvara. Abiks on ka Mati Erelti, Tiiu Erelti, 

Kristiina Rossi “Eesti keele käsiraamat” ja Tiiu Erelti “Eesti ortograafia”. Internetis leiab 

„Õigekeelsuse sõnaraamatu“ aadressilt www.eki.ee/dict/qs2006/. 

Kirjavigade vältimine. Autor peab oma teksti korduvalt hoolikalt kontrollima. Soovitatav on 

õigekirja kontrollida tekstiredaktori (speller) abil (termineid tekstiredaktor küll sageli ei 

tunne) ning paluda töö kellelgi teisel läbi lugeda, sest kõiki oma vigu autor ise tavaliselt ei 

märka. 

2.6. Juhendaja ja õppuri koostöö 

Juhendamine saab alguse juhendaja ja üliõpilase/õpilase  vahelisest kokkuleppest.  

 

 

Esmase valiku tegemisel võib õppur lähtuda õppetooli õpetajate nimekirjast, arvestada oma 

eelnevaid kontakte ning koostööd jmt. Teatud asjaoludel (näiteks juhendajal on juhendatavate 

nimekiri juba suletud) on õppejõul õigus juhendamisest keelduda. Juhendajavaliku 

probleemide korral võib õppur pöörduda spetsialiseerumisala õppetooli juhtivõpetaja poole. 

Juhendaja ülesanne on suunata üliõpilast töö kavandamisel ja tegemisel ning anda nõu 

probleemide sisuliseks lahendamiseks. Juhendaja koostab ka lõputöö ülesande, milles on 

määratletud töös lahendatavad ülesanded.  

 

 

Lõputöö kirjutamine on eelkõige iseseisev töö. Kui tekib küsimusi või probleeme, tuleb 

pöörduda teema juhendaja poole, nõu võib küsida ka teistelt õpetajatelt.  

Lõputöö tuleb vormistada käesolevas juhendis esitatud nõuete kohaselt. Juhendaja vaatab töö 

läbi ning juhib üliõpilase tähelepanu selle nõrkadele kohtadele, hindab uurimismetoodikat, 

materjali esitust, osutab ebatäpsetele terminitele, kordamistele ning keele ja stiili puudustele.  

Juhendamise sisu oleneb töö valmidusastmest. 

Tulevase juhendaja õigeaegne valimine ja tema nõusoleku taotlemine on 

õppuri ülesanne. 
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Õppur on kohustatud kinni pidama õppetooli poolt kehtestatud tähtaegadest, mis tehakse 

teatavaks kooli koduleheküljel.  

Lõputöö tiitellehe pöördel kinnitab üliõpilane oma allkirjaga, et ta on töö teinud iseseisvalt 

ning et kõigile töös kasutatud teiste autorite töödele ja andmeallikatele on viidatud (vt lisa 2a).  

Juhendaja vastutus 

Juhendaja roll on nõustav ja suunav, mitte etteütlev ja ärategev. Tööde juhendamine võib 

toimuda individuaalselt või grupis eriseminarides. Aktiivseks pooleks koostöös on õppur. 

Juhendaja vastutab teema korrektse sõnastuse, erialase kirjanduse kättejuhatamise ning 

konsultatsiooniaja võimaldamise eest.  

Töö kvaliteedi eest vastutab üliõpilane. 

 

 

 

 

 

 

 

Juhendaja vastutus on kehtestada nõuded kvaliteedile ja hinnata nende põhjal töö käiku ja 

tulemusi. Töö kaitsmisel juhendaja avaldab arvamust lõputöö kirjutamisprotsessi kohta ning 

hindab õppuri panust töö kirjutamisel. Juhendaja arvamus lõpliku hinde määramisel on 

soovitusliku iseloomuga.  

Juhendaja ei ole õppuri töö kaasautor ega toimetaja ning tema ülesanne ei ole 

parandada keele-, stiili- ja vormistusvigu. Oma töö andmete ja seisukohtade 

õigsuse eest vastutab ainult õppur. Tehtud märkuste põhjal korrigeerib 

koostaja oma lõputööd ja esitab selle siis kaitsmiseks. 

Juhendajal on keskne osa järgmiste töö elementide kujundamisel:  

� teema valik, 

� probleemi ja uurimisküsimuste sõnastamine, 

� kirjanduse soovitamine, 

� metoodika ja andmetöötlusskeemide valik, 

� järelduste sõnastamine. 



 22 

Lõputöö esitamine kaitsmiseks  

 

 

Lõputööd võidakse kaitsmisele mitte võtta, kui esinevad järgmised puudused:  

� töö ei vasta teemale;  

� töö eesmärk ja peamised ülesanded on sissejuhatuses selgelt välja toomata ja 

määratlemata.  

� tööl puudub teadustööle omane struktuur või mõni töö osa puudub;  

� viidatud allikate loetelu on ebakohane ja/või ebapiisav;  

� tehniline vormistus läheb oluliselt lahku käesoleva juhendi nõuetest;  

� kokkuvõte ei anna ülevaadet töös tehtust, autori järeldustest ega panusest;  

� töö koostamise graafikust ei ole kinni peetud;  

� töö osutub plagiaadiks.  

Tekkinud raskustest, probleemipüstituse või teema sõnastuse muutmisest vms on õppur 

kohustatud informeerima esmalt juhendajat. Kui lahendust ei leita, tuleb pöörduda õppetooli 

juhtivõpetaja poole. 

 Lõputööde retsenseerimise, kaitsmise ja hindamise täpsemad reeglid kehtestavad õppetoolid. 

Lõputöö saab kaitsmiseks esitada juhendaja nõusolekul, kes kinnitab seda oma 

allkirjaga lõputöö tiitellehe pöördel.  
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3. Töö vormistamine  

3.1. Üldnõuded  

Kursusetöö, kursuseprojekt, õpimapp või referaat esitatakse formaadis A4 kiirköitjas ühes 

eksemplaris, lõputöö aga kõvas köites kahes eksemplaris. Kõvas köites esitatavate tööde ette 

ja taha tuleb paigutada üks valge leht (nn köiteleht) ning tagakaane sisekülg varustada taskuga 

juhendaja arvamuse, retsensiooni ja CD tarvis. Kõige olulisem on meeles pidada, et kogu töö 

peab olema vormistatud ühtses stiilis.  

CD-le tuleb lõputöö salvestada täies mahus pdf-failina, CD-l tuleb esitada ka töös kasutatud 

suuremahulised algandmed. Lõputöö põhiosad ja nende järjestus on järgmine:  

� tiitelleht;  

� sisukord;  

� sissejuhatus;  

� sisupeatükid;  

� kokkuvõte;  

� viidatud allikad;  

� lisad.  

Vajadusel on töö osadeks veel lühendite loetelu, kasutatavate võõrkeelsete terminite loetelu ja 

muud lisad. Ühe õppeaine raames tehtavas kirjalikus töös ei pruugi kõik loetletud põhiosad 

olla kohustuslikud, selle üle otsustab õpetaja.  

Töö vormistamisel tuleb arvestada järgmist:  

� Töö trükkida arvutil dokumendina formaadis A4 (210 x 297 mm) lehe ühele küljele. 

� Lehe servad jätta vabaks (File → Page Setup), kusjuures üleval (Top) ja all (Bottom) 

peab olema 2,5 cm, paremal (Right) 2 cm ja vasakul (Left) 3 cm vaba ruumi (sõltub 

köitmisviisist). 

� Töö põhitekst trükkida kirjatüübis Times New Roman (valik dialoogiaknas Font) 

kirjasuurusega 12 punkti, reavahega 1,5 (Format → Paragraph → Line Spacing: 1.5 

lines). 
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� Töö tekst jaotada lõikudeks, kasutades plokkstiili, st. eraldades tekstilõigud laiema 

vahemikuga (6 punkti e. üks tähekõrgus: Format → Paragraph → Spacing: after  ja 

Before 6 pt).  

 

 

� Töö iseseisvaid põhiosi (sisukord, sissejuhatus, uus peatükk, kokkuvõte, kirjanduse 

loetelu, resümee) alustada uuelt leheküljelt. Tekst joondada mõlema serva järgi 

(tekstipaigutus Justify). 

� Tekstis tekkivate põhjendamatute lünkade (nn. aukude) korral kasutada poolitamist. 

Poolitamiseks on paljudes programmides eesti keelele sobivad automaatsed vahendid, 

kuid soovitatav on kasutada klahvikombinatsiooni <Ctrl>+<−>, mis on nähtav vaid 

juhul, kui sõna vajab poolitamist. 

� Kõik töö leheküljed tuleb nummerdada ühtsesse süsteemi ja lehekülje number paigutada 

lehe alla keskele, kusjuures arvesse võetakse ka leheküljed, kus asuvad tabelid ja 

joonised, viidatud allikate loetelu jm. Tiitelleht, tiitellehe pööre, eessõna, sisukord ja 

sissejuhatuse esimene lehekülg võetakse nummerdamisel küll arvesse, kuid lehekülje 

numbreid neile ei märgita, seega lehekülje numbrid märgitakse alates sissejuhatuse 

teisest leheküljest. Lehekülje numbrid lisatakse automaatselt Insert → Page Numbers, 

kusjuures numbri kaugus lehekülje alaservast (jalusest: footer) määratakse kaugus 

lehekülje alaservast (jalusest: footer) määratakse korraldusega File → Page Setup. 

Selleks, et esimestel lehekülgedel lehekülje numbrid ei oleks nähtavad, tuleb tiitellehe, 

selle pöörde, eessõna ja sisukorra järel kasutada sektsiooni katkestust Insert → Break → 

Next page. korraldusega File → Page Setup.  

� Pealkirjades sõnu ei poolitata, lühendeid ei kasutata ja pealkirja lõppu punkti ei panda. 

Pealkirjad joondatakse lehe vasakusse serva (tekstipaigutus Align Left).  

� Esimese astme, teise astme ja kolmanda astme pealkirja vahele jätta üks tühi rida 

suurusega14 pt. Pealkirja ja järgneva (või samal leheküljel eelneva) teksti vahe on 12 

punkti. 

� Teksti trükkimisel vajutada klahvi <Enter> mitte iga rea lõpus, vaid 

ainult lõigu lõpetamisel. Taandridu lõikude tähistamiseks ei 

kasutata. 



 25 

� Töö põhiosade (sh. peatükkide) pealkirjad kirjutatakse püstkirjana suurte tähtedega 

kirjatüübis Arial või Times New Roman rasvases kirjas (Bold) kirjasuurusega 16 punkti. 

� Teise astme pealkirjad kirjutatakse püstkirjana tavaliste tähtedega kirjatüübis Arial või 

Times New Roman rasvases kirjas (Bold) kirjasuurusega 14 punkti. 

� Kolmanda ja järgnevate astmete pealkirjad kirjutatakse püstkirjana tavaliste tähtedega 

kirjatüübis Arial või Times New Roman rasvases kirjas (Bold) kirjasuurusega 12 punkti. 

� Kõikide astmete pealkirjades kasutada vaid ühte kirjatüüpi (kas Arial või Times New 

Roman) 

� Loetelude trükkimisel on reavahe 1,5 ja lõiguvahe 0. 

� Töö ühtki osa ei ole soovitav alustada ega lõpetada loetelu, joonise, tabeli või viitega. 

Tiitellehel peab olema:  

� kooli, õppetooli, osakonna  nimi;  

� lõputööl kooli  sümbol;  

� autori ees-ja perekonnanimi;  

�  õpperühm; (ei kirjutata lõputöö puhul) 

� töö pealkiri;  

� töö liik (nt referaat, kursusetöö, lõputöö);  

�  töö juhendaja eesnimi ja perekonnanimi; 

� töö valmimise koht (Väimela) ja aasta.  

Tiitellehe iga element paikneb omaette real, töö valmimiskoht ja aastaarv samal real, koma 

nende vahele ei panda. Iga rida algab suurtähega ning rea lõpus punkti ei ole. Kõik tiitellehe 

elemendid paigutada lehe keskele ja trükkida kirjasuurusega 12 pt (v.a töö pealkiri). Autori 

ees- ja perekonnanimi paikneb lehekülje 2/3 kõrgusel pealkirja kohal. Töö pealkiri 

vormistatakse rasvases kirjas (Bold) suurtähtedega kirjasuurusega 16–20 pt. Poolitusi ning 

lühendeid reeglina pealkirjades ei kasutata. Töö juhendaja nime ette lisatakse tema ametikoht 

koolis.  

Tiitellehe näidis on lisas 2 ning tiitellehe pöörde näidis lisas 2a.  

Sisukorras (vt lisa 3) esitatakse kõik töö alljaotised täpses vastavuses pealkirjade ja 

leheküljenumbritega, kus vastav alljaotis algab. Järjenumbritega (kümnendsüsteemis araabia 
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numbrid (nt 1.; 1.2.; 1.2.1) tähistatakse ainult sisulise osa peatükid ja nende allosad. Kõik 

lisad kantakse sisukorda koos pealkirjaga. Sisukorra lõppu pannakse kirja ka töö lahusosad (nt 

joonised), millel pole leheküljenumbrit. Leheküljenumbri tulba kohale ega numbri ette ei 

panda lühendit „lk“. Alajaotiste pealkirjad algavad taandega nii, et iga järgmise astme 

alajaotuse taane jätab eelmise astme järjenumbri vabaks (omaette tulbaks). Pealkirjade järele 

pannakse punktirida ning selle lõppu leheküljenumber. Sisukorra esimene kirje on „Sisse-

juhatus“ mitte tiitelleht, eessõna ega sisukord ise.  

Sisukorda saab arvutil koostada automaatselt, kui töös esinevate pealkirjade vormistamisel 

kasutada pealkirjastiile (Heading1, Heading2 …). Selleks tuleb kursor viia sisukorra 

leheküljel tühjale reale ja valida Insert→Index and Tables → Table of Contents (alates 

Word2003 tuleb valida Insert →Reference →Index and Tables → Table of Contents) ning 

avanevas dialoogiaknas anda käsud sisukorra vormistamiseks: näidata leheküljenumbrid 

(Show Page Numbers), joondada need paremale (Right Align Page Numbers), kasutada 

pealkirja ja leheküljenumbri vahel täitesümboleid (Tab Leader rippmenüü), määrata sisukorra 

vormindus (Formats pakub erinevaid võimalusi, mis kuvatakse aknas Preview), enam 

kasutatakse vormi From Template. Show Levels määrab mitu taset pealkirjahierarhiast 

sisukorda lülitatakse. Sisukorda on otstarbekas koostada juba töö tegemise käigus, sest lingid 

sisukorras toodud pealkirjadest viivad vastava teksti juurde, kiirendades nii liikumist töös. 

Enne lõpliku töö väljatrükkimist tuleb veel kord anda sisukorra moodustamise käsk, kus 

arvuti küsib asendamist (Replace), millele tuleb vastata jaatavalt. Arvuti koostatud sisukorra 

eeliseks on see, et sisukorda lülitatud pealkirjad ning nende leheküljenumbrid sisukorras ja 

töös on täpses vastavuses. Samas tuleb jälgida, et automaatselt moodustatud sisukord 

tervikuna oleks kirjasuurusega 12 punkti ega tõuseks erinevate pealkirjastiilide tõttu liialt 

esile. 
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3.2. Viitamine  

3.2.1. Üldpõhimõtted  

Eestis ühtset viitamisstandardit ei ole, iga õppeasutus võib viitamissüsteemi (vt jaotisi 3.2.2 – 

3.2.4) ise valida.  

 

 

 

 

 

Üldteada andmetele ei pea viitama. Üldteada olevateks loetakse andmeid, mida on võimalik 

leida paljudest allikatest (nt entsüklopeediatest, sõnaraamatutest, õpikutest). Samuti peab igal 

juhul viitama sellisele allikale, millest on töö koostamisel võetud palju informatsiooni, isegi 

siis, kui tegemist võib olla üldteada olevate andmetega. Kahtluse korral, kas tegemist on 

üldteada andmetega või mitte, tuleb kindlasti allikale viidata.  

Näide. Viitama ei pea üldjuhul allikale, kust võeti Eesti taasiseseisvumise kuupäev (20. 

august 1991) või nt väljend „Oidipuse kompleks“.  

 

 

 

 

 

 

Kui laused, mõtted, ideed või andmed ei ole kättesaadavad algallikast, võib 

viidata neile lausetele, mõtetele, ideedele või andmetele muude allikate kaudu. 

Siis peab viitama esmalt allikale, mille kaudu viidatakse ning seejärel allikale, 

millele viidatakse. 

Ei tohi viidata allikale, mida autor ei ole ise näinud. 

 

Referaadis, ainetöös, kursusetöös või -projektis, praktikaaruandes ja  

lõputöös peab viitama kõigile kasutatud allikatele ning neist võetud 

lausetele, mõtetele, ideedele või andmetele. Vastasel korral võidakse 

autorit süüdistada plagiaadis. Plagiaat ei ole üksnes terve töö 

esitamine oma nime all, vaid ka võõraste lausete, mõtete, ideede või 

andmete kasutamine ilma korrektse viitamiseta.  
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3.2.2. Viitamissüsteemid 

Uurimistöödes kasutatakse põhiliselt kolme viitamissüsteemi:  

� nime-aasta-süsteemi korral järjestatakse viitekirjed loetelus perekonnanimede 

tähestikjärjekorras, eesnimi või selle esitäht komaga eraldatult nime järel. Kirjeid  ei 

nummerdata. Seda viitamissüsteemi kasutatakse enamasti loodus-, täppisteadus-  ja 

sotsiaalteaduste töödes;  

�  numbrisüsteem, mille puhul kirjed nummerdatakse, võib paremini sobida tööle, milles 

tuleb viidata paljudele autorita dokumentidele, juhenditele vms;  

� joonealust viitamist kasutatakse peamiselt humanitaaralastes töödes, milles on rohkesti 

tsiteeringuid.  

 

 

 

 

 

Viitamine koosneb kahest osast. Esiteks tuleb viidatava teksti lõppu, joonise või tabeli juurde 

lisada viide. Teiseks peab töö lõpus olema iga viite kohta bibliograafiline kirje. Viidatud 

allikate loetelus peab olema viide kõigi töös viidatud allikate kohta. 

3.2.3. Viitamine nime-aasta-süsteemis   

Viite koostis ja paigutus sõltuvad viidatavast teosest, allikate arvust, autori nime esinemisest 

lauses ning refereeringu pikkusest.  

 

 

 

Aastaarvule järgneb koolon, tühik ning viidatava allika leheküljenumber või -numbrid. Kui 

viidatakse mitmele järjestikusele leheküljele, pannakse numbrite vahele mõttekriips.  

Viitamissüsteem peab kogu töö ulatuses olema ühtne.  

Ühes töös tohib kasutada ainult ühte viitamissüsteemi. 

Võrumaa Kutsehariduskeskuse õppurite poolt koostatud kirjalikes töödes peab 

viites, mis koosneb tsitaadi või lühirefereeringu lõppu või pikema refereeringu 

algusse lisatud sulgudes olevale autoriinimest (kui autorit ei ole, siis pealkirja kaks 

esimesest sõna) ja aastaarvust, olema osutatud refereeritud töö leheküljenumbrile 

või -numbritele. 
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Kui refereering koosneb ühest lausest, siis paikneb viide (autor aasta: lehekülje number) enne 

lauset lõpetavat punkti, mitmelauselise refereeringu korral asub viide pärast viimast 

lausetlõpetavat punkti. 

Näide: 

 

 

 

 

 

 

 

 

 

 

 

Kui viidatava autori nimi sisaldub juba töö kirjutaja enda lauses, siis autori nime ei ole vaja 

viites korrata. Autori nime järgneb pärast tühikut sulgudes aastaarv ning sellele järgneva 

kooloni järel leheküljenumber või -numbrid.  

Kui viidatakse mitmele sama autori tööle, ei ole autori nime vaja korrata. Tööde ilmumis-

aastad eraldatakse üksteisest komaga ning esitatakse ilmumisaastate kronoloogilises 

järjestuses.  

Viitamisel sama autori mitmele tööle ei ole autori nime vaja korrata, tööde ilmumisaastad 

eraldatakse üksteisest semikooloniga. 

 
Majandusteadust on defineeritud kui teadust, mis uurib inimese käitumist 

sõltuvana tema eesmärgi ja võimaluste mittevastavusest (Vensel 1979: 7). Samu 

aspekte on rõhutatud ka majanduse üldteooria määratluses: ”Majanduse üldteooria 

on õpetus olemasolevate piiratud ressursside võimalikult efektiivsest kasutamisest 

inimeste kasvavate vajaduste rahuldamiseks” (Arrak 1991: 9). 

Kvalitatiivse analüüsimeetodi aluseks on sõnad ning andmete analüüsimisel on 

vajalik hea analüüsioskus. Uurija püüab samaaegselt toime tulla andmete 

kogumisega, korrastamisega, süstematiseerimisega ja andmete tahenduse tõlgen-

damisega. (Burns jt 1993: 563). 

või 

Burns jt (1993: 563) on kirjutanud, et kvalitatiivse analüüsimeetodi aluseks on 

sõnad ning andmete analüüsimisel on vajalik hea analüüsioskus. Uurija püüab 

samaaegselt toime tulla andmete kogumisega, korrastamisega, süstemati-

seerimisega ja andmete tähenduse tõlgendamisega. 
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Kui ühelt autorilt on kasutatud mitut sama aasta jooksul ilmunud tööd, siis tuleb kasutada 

erinevuse väljatoomiseks tähiseid a, b, c. 

Näited: 

 

 

 

 

 

 

 

 

 

 

Kui viidataval allikal on autoreid rohkem kui kaks, võib viites tuua ainult esimese autori 

perekonnanime ja lisada lühend „jt“ või et al. (kaldkirjas ladinakeelse lühendi – et alii – lõppu 

pannakse punkt). Kahe autori nime vahele pannakse „ja“. 

Näide: 

 

 

 

Kui teosel puudub autor, tuleb viites märkida pealkirja esimene sõna (või esimesed sõnad), 

mille järgse tühiku taha pannakse kolm punkti,  ilmumisaasta ja leheküljed. 

 
Elmo Tamme (2003: 23–24) arvutuste kohaselt … (viitamine ühe autori 

ühele tööle)  

 
E. Tamm on kirjutanud (2003: 23–24), et …(viitamine ühe autori ühele 
tööle)  
 
Kask ja Tamm (1994: 12) on lähtunud …(viitamine kahe autoriga tööle)  
 
……… (Fillick 1993: 18; 1996: 24). (viitamine sama autori mitmele tööle) 

 

……… (Tammik 2001a: 23). (ühelt autorilt on kasutatud mitut sama aasta 

jooksul ilmunud tööd) 

 
……… (Tammik 2001c: 62). 
 

Alver (1995: 12; 1994a: 18; 1994c: 23; 1989: 234) kirjeldab olukordi, 
kus…  

 
(autori mitmele tööle korraga viidates tuleb tööd reastada kõige 

värskemast kõige vanemani; kui samal aastal on ilmunud mitu tööd, 

lisatakse alfabeetilises järjestuses täht publitseerimise aasta juurde).  

 

 
… (Smith et al. 1995: 132). 
… (Kase, Saar 2001: 101). 
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Näide: 

 

 

Kui viidatakse entsüklopeedia või sõnaraamatu märksõnale, märgitakse teatmeteose pealkiri 

või selle lühend, ilmumisaasta, selle järele lühend sub. (ladina keeles sub verbo – sõna all) 

ning teatmeteose märksõna. 

Näide: 

 

Kui viidatakse ühele ja samale allikale ühel leheküljel mitu korda, on soovitatav pärast 

esimest viidet kasutada järgmistel kordadel ladinakeelset lühendit Ibid (ibidem – sealsamas). 

Näide: 

 

 

Arhiivimaterjalidele viidates tuleb esmakordse viitamise korral joone all kirjutada välja 

arhiivi täielik nimetus koos kasutatava lühendiga (nt Eesti Ajalooarhiiv (EAA)); seesama 

lühend tuleb esitada ka lühendite loetelus. Pärast arhiivi nimetamist viidatakse joonealuses 

allika muudele arhiiviandmetele kindlas järjestuses, kasutades järgmisi lühendeid: fond – f, 

nimistu – n, säilik – s, säiliku leht – l, säiliku lehe pööre – l 3p. 

Näide: 

 

Kui esmaallikat ei ole kasutatud, võib selle viidata kaudselt – originaalteose viitele järgneb 

viide sekundaarallikale. Seda tehakse tsiteerimise puhul  ja juhul, kui algallikat ei ole 

võimalik kätte saada ja antud teose kasutamine on töös vältimatult vajalik. 

 Näide: 

Enamikku metalle saab valtsida nii külmalt kui kuumalt (EE 1998 sub valtsimine). 

…… (Eesti arengu … 1999: 41). 
 
…… (Eesti infopoliitika … 2000: 64). 

 
(Lipp 2008: 10) ja hiljem (Ibid.: 15) või (sealsamas: 15) 

… (Devereux 1989: 23-30, viidatud Grier, Perry 1998: 674 vahendusel) 

EAA, f 10, n 3, s 200, l 40. 
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Seadustele, määrustele, komiteede otsustele vms (publikatsiooni autor ei ole teada) viida-

takse publikatsiooni pealkirja ja aastaarvuga, mõnikord ka neid välja andnud organisatsiooni 

nime (või selle lühendi) ja aastaarvuga.  

Näide: 

 

 

Õigusakti viitamisel kirjutada akti nimetus (nimetuse 1 - 2 esimest sõna ja kolm punkti), 

ilmumise aasta, kui õigusaktil on paragrahv, siis paragrahvi number. 

Näide: 

 

Kui tekstis viidatakse õigusaktidele, võib kasutada õigusakti pealkirja või järgnevatel 

viitamistel pealkirja lühendit. 

Näide: 

 

Õigusakti sätete nimetused (näiteks “paragrahv” või “lõige”) on soovitav välja kirjutada lause 

alguses. Lause keskel võib kasutada ka lühendeid ja sümboleid. 

Näide: 

 

 

Internetist saadud materjalide korral viidatakse teose autorile või (kui autor ei ole teada) peal-

kirjale või   kodulehe pealkirjale ning aastale. Kui internetimaterjali (harilikult pdf-failide) 

kohta on teada ka ilmumisaasta ja maht (lehekülgede arv), siis tuleb sellele materjalile viidata 

nagu paberväljaandele (autori või pealkirja esimes(t)e sõna(de), ilmumisaasta ja 

(Kasuliku mudeli... 2004: § 5). 

Äriseadustiku (ÄS) kohaselt … 

Paragrahvis 8 tuuakse … 

Äriseadustiku § 13 põhjal …  

 
Olukorra hindamisel on infoturbe juhendit (RIA 2004) … 



 33 

leheküljenumbri kaudu). Internetiallikale, mille autorit ei ole võimalik kindlaks teha, tuuakse 

viites allika pealkiri või teksti esimene sõna ning allika avaldamise aasta. Kui internetiallika 

avaldamise aastat ei ole võimalik kindlaks teha, siis märgitakse kuupäev ja aasta, mil õppur 

seda allikat internetist luges.  

Näide: 

 

 

 

Kirillitsas koostatud teostele viidatakse kirillitsas. Kui seda millegipärast ei saa teha, 

transkribeeritakse autori nimi või pealkirja algussõnad ladina tähestikku. Vene-ladina 

transliteratsiooni reeglid on toodud M. Erelti, T. Erelti ja K. Roosi “Eesti keele käsiraamatus” 

(Erelt M. et al. 2001: 55). 

3.2.4. Viitamine numbrisüsteemis  

Õppurite töödes, mille põhilised kirjandusallikad on juhendid, standardid, õigusaktid vms, 

(tehnikateadustes) viidatakse numbrisüsteemis. Taoline viitamisviis on nii töö koostajale kui 

ka lugejale suhteliselt tülikas, sest autorit on vaja otsida töö lõpust ning viidete numbreid saab 

teksti kirjutada alles siis, kui kirjanduse loetelu on lõplik.  

Numbrilise viitamise puhul pannakse viidatava teksti lõppu nurksulgudes olev viitenumber 

(viidatava allika järjekorranumber viiteloetelus), mis peab ühtima viidatud allikate loetelus 

olevaga. Viitenumbrile lisatakse võimalusel allika lehekülje number, kust pärineb tsitaat või 

refereering.  

Näide:  

 

Tellitud kõrgharidust tõendavate dokumentide plangid väljastab REKK 

kõrgkoolijuhile või tema volitusel kõrgkooli esindajale üleandmis-vastuvõtmise 

akti või kõrgharidust andvatele kutseõppeasutustele saatelehe alusel 

(Lõpudokumendid … 26.10.06). 

NB! Interneti allika viitamisel tekstis ei märgita aadressi, veebilehe 

aadress kirjutatakse koos külastuse päevaga allikaloendisse! 

Tööjõud, tootmisvahendid ja materjal on tootmistegurid, mille kombinatsioonina 

majandus- (tootmis-)protsess toimub [2: 8]. 
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Kui viidatakse mitmele allikale, pannakse viitesse kõigi viidatud publikatsioonide 

järjekorranumbrid kasvavas järjestuses, nt [12, 17, 21, 34]. 

 

 

 

3.2.5. Joonealune viitamine 

Joonealust viitamist kasutatakse väiksema mahuga kirjalike tööde (artiklid, referaadid jm) 

puhul. Samuti sobivad joonealused viited intervjuude, dokumentide, aruannete jm puhul. 

Joonealusel viitamisel tuleb tekstisiseselt näidata joonealuse viite järjekorranumber pool astet 

reast kõrgemal. Joone pikkus teksti all peab olema 1/5…1/3 teksti laiusest. Joon algab teksti 

vasakpoolsest servast. Joonealuse teksti kirjatüüp on Times New Roman kirja suurusega 10 pt. 

Kui väiksema mahuga töödel on mõnel leheküljel mitu joonealust viidet, võib igal leheküljel 

alustada viidete uut numeratsiooni. Ühel leheküljel võib olla kaks-kolm joonealust viidet. 

Tavapärane joonealuste viidete numeratsioon on pidev kogu töö ulatuses. Pidevjoone all saab 

näidata kõik allika kohta vajalikud andmed. Viite lõppu kirjutatakse leheküljenumber.  

Näide: 

 

 

 

Joonealuseid viiteid ei ole otstarbekas nummerdada käsitsi, vaid kasutada selleks arvuti poolt 

võimaldatavat automaatset nummerdust. Microsoft Wordi puhul saab selleks kasutada Insert-

Footnote teksti paigutajat. Sel juhul lisandub uue viite märge automaatselt õigele kohale ning 

viited hoitakse viidatava kohaga samal leheküljel ka teksti paigutuse muutumisel.  

Joonealuse märkusena võib tuua autori poolt tõlgitud võõrkeelse(te) lause(te) eestikeelse 

tõlke. Tsiteeritav võõrkeelne tekst kirjutatakse muu teksti vahel kursiivis (Italic), 

jutumärkides. 

Numeratsiooni alustatakse esimesest viitest tekstis. Kui ühte 

kirjandusallikat refereeritakse mitmes kohas, siis selle järjekorranumber 

viites säilib. 

Kõige tüüpilisem Soome kaljutaide motiiv on lihtsate joontega visandatud 

ebasümmeetriliste konksus põlvedega eestvaates inimene
1)

.  

________________________ 
1) Kõiva, M., Kuperjanov, A. (2002). Mäetagused 17-18. Tartu, lk 144. 
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3.2.6. Viiteloetelu nime-aasta-süsteemis  

Ainetöö, referaadi, kursuseprojekti, kursusetöö, praktika aruande ja lõputöö lõpus peab olema 

viidatud allikate loetelu ehk nimestik, milles esitatakse töö kirjutamisel kasutatud allikate 

(raamatute, artiklite jm) viitekirjed. Nime-aasta-süsteemis loetelu, mida ei nummerdata, peab 

sisaldama kõiki allikaid, millele on töös viidatud, ning iga allika kohta peab töös leiduma 

viide. Esmalt tuuakse ladinatähestikuline (nii eesti- kui ka võõrkeelne) ning seejärel kirillitsas 

kirjandus. 

Viitekirje peab sisaldama järgmisi elemente, mis on vajalikud allika identifitseerimiseks ja 

ülesleidmiseks:  

� autori nimi koos initsiaali või eesnimega; kui autoreid on rohkem kui kolm, võib esitada 

ainult esimesed koos lühendiga „jt“ (inglis, saksa ja prantsuse keeles ladina-keelne et 

al., vene keeles „и др.“);  

� pealkiri;  

� alapealkiri (eraldatakse põhipealkirjast märgiga : ja alustatakse väiketähega);  

� kordustrükis ilmunud teostel trüki järjenumber (see märgitakse lühendatult, araabia 

numbriga, nt 3. tr või 3.,täiend. tr., kuigi tiitellehel võis olla Kolmas, täiendatud trükk);  

� väljaandmiskoha (linna) ja kirjastuse nimi (eraldatakse teineteisest märgiga : );  

� ilmumisaasta;  

� lehekülgede üldarv.  

Andmed teose kohta saadakse tiitellehelt ja/või selle pöördelt.  

Viitekirjed esitatakse loetelus autorite perekonnanimede tähestikjärjestuses, eesnimi või selle 

esitäht komaga eraldatult nime järel. Kui autoreid pole tiitellehel (või selle pöördel) näidatud, 

koostatakse kirje pealkirja järgi. Siis kirjutatakse pealkirja järele kaldkriipsuga eraldatult 

koostaja või tiiteltoimetaja nimi (siin eesnimi või initsiaal alati perekonnanime ees). Pealkirja 

järel näidatakse ka kollektiivautor, s.t selle asutuse nimi, kelle töötajad teose kirjutasid või 

koostasid. Mitme autori puhul esitatakse nimed tiitellehel esinevas järjekorras.  

Kõik viitekirje elemendid, sh lühendid, peavad olema väljaande keeles. Nt number, raamatus, 

lehekülg, trükk ja köide on eesti keeles nr, Rmt, lk, tr, kd; inglise keeles no, In, p., ed., vol.; 

prantsuse keeles n
o
, In, p., éd., t. ning saksa keeles Nr., In, S., Aufl., Bd. 
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Kui töö vormistamisel pole võimalik kasutada kirillitsat, siis on lubatud transkribeerida 

kirjandusallikaid ladina tähestikku. Sellisel juhul kirjutatakse autori nimi transkribeeritult ning 

artikli pealkiri tõlkena, võttes need artikli võõrkeelsest kokkuvõttest (kui see on olemas). Kui 

võõrkeelne kokkuvõte või rööppealkiri puudub, tõlgitakse pealkiri võimalikult täpselt ise ja 

pannakse kirjes nurksulgudesse. Ajakirja või muu allika pealkiri kirjutatakse kas vastavalt 

olemasolevale rööpnimetusele (kui see on olemas) või transkribeeritakse. Kirje lõppu 

lisatakse sulgudes märge originaali keele kohta, nt „vene keeles“. 

 

 

 

 

 

Raamatu kirje autori järgi. Raamatuid kirjeldatakse autori(te) perekonnanime järgi. Kui on 

tegemist ühe peatükiga kollektiivselt kirjutatud raamatust, siis autoriks ei ole mitte raamatu 

koostaja, vaid antud peatüki kirjutaja. Kui raamatu autoriks on kollektiiv või autorit ei ole 

antud, siis kindlasti on raamatul olemas toimetaja või koostaja, viites asendada autori nimi 

toimetaja/koostaja nimega ning nime taha kirjutada sulgudesse (toim/koost).  

Raamatu pealkiri tuuakse ära täielikult, seda lühendamata. Kordustrükkide puhul märgitakse, 

mitmenda trükiga on tegemist, see kirjutatakse araabia numbriga koos iseloomustusega 

(näiteks 3. parandatud trükk või 2nd ed).  

Ilmumiskoha ja kirjastuse (väljaandja) nimi esitatakse täielikult ning nende vahele trükitakse 

koolon. Kui raamatu ilmumiskohta pole antud, siis märgitakse s.l. (sine loco- ilma kohata), 

kui raamat on välja antud mitmes kohas, piisab neist ainult ühe (harilikult esimese) 

märkimisest. Ilmumisaasta puudumisel kasutatakse lühendit s.a. (sine anno- ilma aastata).  

Viidatud allikate loetelus tuleb allikad nummerdada ja tähestikuliselt 

järjestada. Kirjanduse loetelu tähestikulise järjestuse loomiseks arvutil tuleb 

kogu loetelu märgistada ja valida korraldus Table → Sort → Sort by 

Paragraphs, Ascending. Saadud alfabeetiline loetelu tuleb nummerdada: 

Format → Bullets and Numbering → Numbered (1., 2. jne.). 
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Näited: 

 

 

 

 

 

 

 

 

Ajakirjaartiklite kohta kirjutatakse viiteloetelus järgmised andmed: Autor, initsiaalid. 

Ilmumisaasta. Pealkiri. – Väljaande nimetus, köide(number), leheküljed.  

Näide: 

 

 

 

 

 

 

 

Artikkel kogumikus (raamatus). Kui viidatakse mingile kogumikuartiklile, tuleb esitada 

andmed järgmise skeemi alusel: Artikli autor, initsiaalid. ilmumisaasta. Artikli pealkiri. – 

Kogumiku nimetus. Ilmumiskoht: kirjastus, artikli leheküljenumbrid. 

 
Jagomägi, T. 1999. Geoinformaatika praktikule. Tartu: Regio. 74 lk. 

Laaneots, R., Mathiesen, O. 2002. Mõõtmise alused. Tallinn: TTÜ kirjastus. 

206 lk.  

Peurifoy, R.L., Schexnayder, C.J. 2002. Construction Planning, Equipment, 

and Methods. 6th ed. Toronto: McGraw-Hill. 320 pp. 

Вихански, O. С. 2000. Стратегическое управление. 2-e издание. Москва: 

Гардарики.  296 с. 

OECD majandusuurimused 1999–2000. 2000. Balti riigid: regiooni majandus-

ülevaade. s.l. 265 lk. 

 
Calleja, H., C. Aguilar, V. Cárdenas, and J. Arau. 2001. A Survey of Power 

Metering Technologies. –  Journal of the Mexican Society of Instrumentation. 

Instrumentation and Development. Vol. 5, no 2, pp. 21–25.  

Keedus, K., Uri, V. 1997. Biomassi produktsioon naadi hall-lepikus. – Eesti Loodus, 

nr. 9, lk. 23–28. 

Jaht, V. 2006. Riskide ja võimalustega Ida-Euroopa aktsiaturud. − Ärielu,  nr. 1 

(134), lk. 46–48. 
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Näide: 

 

 

 

 

 

 

 

Näide konverentsiväljaande kohta: 

 

 

 

 

 

Ajaleheartiklitele viitamisel näidatakse enamasti ilmumiskuupäev ja leheküljenumber, kui 

ajaleht koosneb sektsioonidest (osadest), siis ka sektsiooni number. 

Näide: 

  

 

Kui töös viidatakse mõne autori tööle teise allika kaudu, siis tuleb allikaloetelus näidata 

mõlemad. 

Näide: 

 

 

Raus, T., Trasberg, V. 2003. Regionaalsed tuluerisused. − Eesti regionaalarengu 

sotsiaalmajanduslik käsitlus. Vastutav toimetaja H.Kaldaru. Tartu: Tartu Ülikooli 

Kirjastus,  lk. 283–303. 

Maur, E. 1929. Filosoofia praktikule. – Rmt: Veebel, S. (koost.). Filosoofia 

alused. Tallinn: Valgus, lk. 134–160. 

Leppik, L., Võrk, A. 2006. Pension Reform in Estonia. – Pension reform in the 

Baltic States. Edited by E.Fultz. Budapest,  pp. 17-141. 

Raig, I. 2004. Majandusvabadusi kujundav majanduspoliitika Eestis ja selle 

perspektiivid Euroopa Liidus. – Eesti majanduspoliitilised perspektiivid Euroopa 

Liidus. XII teadus- ja koolituskonverentsi ettekanded-artiklid. Tallinn: Mattimar,  lk. 

89−396. 

 
Ruus, J. 1994. Turismiobjektid Tallinnas. – Eesti Ekspress, 17. juuni, 1994, B2. 

 
Pool, T. 2002. Human Behavior. Press, 190 pp. Viidatud Laanemaa, S. 2003. 

Inimloomus. Tartu, 500 lk kaudu. 
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Töö koostamisel kasutatakse sageli ka teisi allikmaterjale: õigusakte, teatmeteoseid, interv-

juusid, dokumente, aruandeid jne. Käsikirjalised materjalid esitatakse viidatud allikate 

loetelus koos trükitud teostega. 

Õigusaktikirjetes (kui viidatakse trükis ilmunud täistekstile) antakse akti nimetus, 

vastuvõtmis-aeg ja andmed algallika kohta. Riigi Teataja lühend on RT ning Riigi Teataja 

Lisa lühend RTL. 

 Näide: 

 

 

1. juunist 2002 antakse Riigi Teatajat välja nii paberkandjal kui ka elektrooniliselt Internetis 

(eRT). Alates 1. jaanuarist 2007 on esmane ametlik väljaanne eRT, seetõttu on otstarbekas 

viidata elektroonilisele väljaandele (eRT). 

Näide: 

 

 

 

Standardi või normdokumendi kirje 

Näide: 

 

 

 

Käsikirjade viitekirje koostatakse nagu raamatule, kusjuures kirjastus või väljaandja on 

institutsioon, milles töö koostati. Sulgudes näidatakse töö liik. Kui kirjest ei selgu, millises 

 
Maaparandusseadus. 2003. – RT I, 2007, 15, 84. 

 
Asjaõigusseadus. 2007. – eRT. [https://www.riigiteataja.ee/ert/act.jsp?id=12807782] 

 
Teraskonstruktsioonid. 2003. Osa 1-1: Hoonete teraskonstruktsioonide 

projekteerimiseeskirjad: Eesti Standard EVS 1993-1-1:2003. Tallinn: 

Standardiamet. 
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asutuses käsikiri kättesaadav on, tuleb see näidata kirje lõpus sulgudes. nt (Käsikiri Eesti 

Maaülikooli farmitehnika ja ergonoomika osakonnas).  

Näide: 

 

 
 

Intervjuu kohta peavad viidatud allikate loetelus olema järgmised andmed: intervjueeritava 

nimi, intervjuu pealkiri, intervjueerija nimi, ilmumiskoht. Kui intervjueerija on autor ise, siis 

tuleb allikmaterjalide loetelus näidata intervjueeritava nimi, intervjuu tüüp (üleskirjutus või 

helisalvestis), intervjueerimisaeg ja koht. 

Näide: 

 

 

Käsikirjaliste aruannete ja dokumentide, millel puudub konkreetne autor, kirjes peavad 

sisalduma: dokumendi nimetus, institutsiooni nimi, väljaandmisaeg ning sulgudes käsikiri.  

Näide: 

 

 

 
 

Teatmeteose artikkel esitatakse analoogiliselt kogumiku artiklile. Kirje võib esitada ka 

lühikirjena, kasutades ladinakeelset lühendit s.v. (sub verbo — sõna all). 

Näide: 
 
 
 
 

Erm, K. 2009. Turundusmeetmestiku analüüs Pergo Hotels AS põhjal: Lõputöö. 

VKHK turismi õppetool, 45 lk (Käsikiri Võrumaa Kutsehariduskeskuse turismi 

õppetoolis).  

Piip, H. 2002. (AS Estiko Plastar müügidirektor). Autori intervjuu. 

Helisalvestis. Tartu, 28. august 2002.  

OÜ Bamboo Azhuu bilanss seisuga 01.01.2009. a. (käsikiri). 

Küsitluse “Välisinvestor 2005” materjalid. 10.10.2006. TÜ välismajanduse 

õppetool. (käsikiri). 

 

Kausaalsus. 1999. Võõrsõnastik. Üldtoim. R. Kull. Tallinn: Tea, lk. 284. 
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Arhiivimaterjalide kohta on vaja esitada järgmised andmed: arhiivi nimetus, fondi (lühend 

f.) number, nimistu (n.) number, toimiku (t.) number, lehe (1.) number. 

Näide: 

 

 

Elektrooniliste materjalide puhul tuleb ära tuua järgnev: 

1) autori(te) nimi (nimed)/organisatsioon/sponsor;  

2) pealkiri või kodulehe pealkiri;  

3) avaldamise aeg;  

4) väljaandja;  

5) dokumendi url-aadress nurksulgudes;  

6) kasutamise aeg ümarsulgudes.  

 

 

 
Näide: 

 

 

 

 

 

 

 

 
EAA, f. 250, n. 3, t. 15, 1. 24. 

Eesti Ajalooarhiiv, f. 250, nim. 3, t. 15, l. 24. 

Kui materjalil autori nimi puudub, siis tuuakse pealkirja või kodulehe 

pealkirja järel organisatsiooni nimetus, kust viidatav materjal pärineb. 

Bernstein, J. 2003. An Overview of MEMS Inertial Sensing Technology. Sensors 

Online, no. 2. [http://www.sensorsmag.com] (26.01.2009)  

Crook, C.S. 1998. Checklist of Conifers in the British Isles. Preston, Lancashire, UK.  

[http://ourworld.compuserve.com/homepages/cameronscrook/] (25.04.2003) 

 

Toomla, R. Rahvusvahelised rahandusorganisatsioonid. 

[http://www.undp.ee/rvo/rro.html] (06.02.2003) 

Maaelu arengu osakonna põhimäärus. Eesti Põllumajandusministeerium. 

[http://www.agri.ee/ministeerium/osakonnad/4_pm.html] (19.08.2003) 



 42 

Kui internetist pärineval materjalil (nt pdf-formaadis dokumentidel) on olemas viitekirje 

koostamiseks vajalikke rekvisiite (ilmumisaasta või maht), siis tuleb need kõik vastavas kirjes 

ära tuua. 

Näide: 

 

 

 

 

 

 

 

Internetiallikad peavad olema üldkättesaadavad, st ei tohi olla parooliga kaitstud. Seega nt 

Äripäeva veebiväljaanne ei ole sobiv allikas. Seega tuleb viidata selle asemel vastavale 

paberväljaandele. 

3.2.7. Viiteloetelu numbrisüsteemis ja joonealusel viitamisel 

Mõlema viitamissüsteemi puhul viiteloetelu kirjed nummerdatakse. Kirjeid võivad loetelus 

järjestada kahte moodi:  

� tekstis viitamise järjekorras või  

� autorite perekonnanimede tähestikjärjestuses või, kui autoreid ei ole märgitud, siis 

pealkirjade järgi, ladina tähestikus kirjed eespool.  

Bibliograafiline kirje koostatakse niisama moodi kui nime-aastaviitamise korral selle 

erinevusega, et ilmumisaasta kirjutatakse ilmumiskoha või kirjastuse järele (koma vahele).   

Eesti väikese ja keskmise suurusega ettevõtete arengusuundumused. 2005. Uuringu 

aruanne. Saar ja Poll OÜ, 103 lk.[http://www.mkm.ee/failid/aruanne_251005.pdf] 

(21.03.2006) 

Bean, Charles. 2004. Bank of England. Asset Prices, Monetary Policy and Financial 

Stability: A Central Banker’s view. January 2004. At the AEA Conference, SanDiego, 

10 p. [http://www.bankofengland.co.uk/publications/speeches/2004/speech207.pdf]. 

(21.09.2009) 

Töötuse määr maakonna järgi. 2006c. Statistikaamet. [http://pub.stat.ee/pxweb. 
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3.3. Tabelid, lisad, joonised, valemid ja loetelud  

Tabelid võimaldavad arvandmeid esitada süstematiseeritult ja ülevaatlikult. Kõik töös 

esinevad tabelid nummerdatakse araabia numbritega kas läbivalt kogu töö ulatuses 

(lihtnumeratsioon), mida soovitatakse väiksema arvu (kuni 10) tabelite korral või suurema 

hulga tabelite korral üksikute peatükkide ulatuses (liitnumeratsioon). Näiteks “Tabel 1” või 

“Tabel 3.4”, kusjuures viimane tähendab kolmanda peatüki neljandat tabelit. Sama moodust 

on soovitatav kasutada ka jooniste ja valemite tähistamisel. 

 

 

Pealkirja sõnastamisel tuleb alustada tabeli sisust, millele järgneb objekti (ettevõtte, riigi jm.) 

nimetus ja lõpuks ajavahemik. 

Tabel ja selle pealkiri joondatakse vasakule või lehekülje keskele, mille ette kirjutatakse sõna 

“Tabel” koos tabeli numbriga (trükkida rasvases (Bold) kirjas) ning pärast tühikut järgneb 

tabeli pealkiri tavalises kirjas kirjasuurusega 12 punkti reavahega 1,5. Pealkirja ja tabeli 

vahele jätta üks tühi rida kirjasuurusega 12 reavahega 0. Kui kõigi tabelis toodud andmete 

kohta saab kasutada ühesugust mõõtühikut, siis tuuakse see ära tabeli pealkirja järel sulgudes. 

Mitme mõõtühiku kasutamisel esitatakse need vastavate veergude või ridade nimetuste juures 

kas sulgudes või eraldades nad eelnevast tekstist komaga. Tekst ja arvud tabelis tuleb esitada 

kirjasuurusega 11 punkti reavahega 1,0 (Single) ja tabel tuleb paigutada lehe keskele (Center). 

Tabelil võiksid olla välimised raamjooned ja soovi korral võib tabeli pea ja esiveeru 

raamistada jämedama joonega. 

Kõigil tabeli veergudel peab olema nimetus, soovitavalt ka esimesel veerul. Veergude 

pealkirjastamisel tuleb vältida üldisi sõnu nagu “liik”, “nimetus” jt., näiteks mitte “Ettevõtte 

nimetus”, vaid “Ettevõte”, mitte “Näitaja nimetus”, vaid “Näitaja” jne. Üldreeglina veerge ei 

nummerdata. Nummerdada tuleb veerud ainult siis, kui selleks on otsene vajadus, nimelt kui: 

� mõne veeru nimetuses on näidatud, kuidas saadakse tulemus antud veergu (näiteks 

veerg 2 + veerg 3); 

� töö tekstis viidatakse tabeli teatud veergudele. 

Teksti paigutatavad tabelid peavad kandma nende sisu ammendavalt 

lahtimõtestavat ja võimalikult lakoonilist pealkirja.  
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Veergude nummerdamisel võib need veerud, kus pole arvandmeid (näiteks veerud 

nimetustega “Näitaja” ja “Mõõtühik”), tähistada vastavalt suurtähtedega A, B jne., ülejäänud 

veerud aga nummerdada 1, 2, 3 jne. 

Tabelites esitatud andmed tuleb siduda töö tekstiga. Selleks kasutatakse: 

� otsest viitamist (näiteks Alljärgnev tabel 3 iseloomustab ...); 

� kaudset viitamist ning sel juhul märgitakse lause lõppu sulgudesse tabeli number 

(näiteks vt. tabel 8). 

Peale sellist viidet tuleb töös esimesel võimalusel esitada tabel. Kui soovitakse tähelepanu 

juhtida töös eespool (näiteks eelmises peatükis) asetsevale tabelile, siis tuleb kasutada kaudset 

viitamist, tuues ära leheküljenumbri, kus see tabel asub (näiteks vt. tabel 11 lk. …). Tabel 

paigutatakse võimalikult tekstilõigu lähedale, milles sellele esmakordselt viidatakse. 

 

 

Näide: 

Tabel 1. Tabeli pealkiri (sisu, objekt, ajavahemik), mõõtühik 

Suure 
algustähega 

Suure 
algustähega 

väikese 
algustähega 

väikese 
algustähega 

väikese 
algustähega 

Suure 
algustähega 

A 1 2 3 4 

..... ..... ..... ..... ..... 

 

Tabelist peavad selguma kasutatud andmete allikad. Kui tabel on koostatud publitseeritud 

andmete põhjal, peab tooma viite allikale, kui on tegemist autori arvutustega või andmetega, 

siis tulebki nii märkida. Esitatav viide on kirjasuurusega 12 punkti reavahe 1,0 (single). 

Näide: 

 

..... ..... ..... ..... ..... 

1996 76,2 7,6 56,9 178,2 
1997 76,9 6,9 54,1 185,4 

Algandmete tabelid esitatakse lisades. 
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Allikas: Eesti piirkondlik … 2001: 17−19, 44−49. 
või 

Allikas: Eesti Statistika … 2001: 117; autori arvutused. 

Kui tabeli mõnes lahtris andmed puuduvad, täidetakse see lahter miinusmärgiga.  

Tabelite vormistamiseks arvutil on mitmeid võimalusi. Valides Table → Insert → Table 

määratakse avanevas dialoogiaknas loodava tabeli veergude (columns) ja ridade (rows) arv, 

hiljem saab vajadusel neid moodustada või ära võtta valikuga Table → Insert või Delete. 

Veergude laiusi saab muuta, vedades hiirekursoriga abijooni või valides Table → Autofit → 

Distributed Columns Evenly. 

Joonised. Selle nimetuse alla kuuluvad kõik töös sisalduvad illustratsioonid, olgu need siis 

diagrammid, graafikud, geograafilised kaardid, joonistused, tehnilised skeemid või fotod.  

Igal joonisel peab olema allkiri, mis joonisel kujutatut lakooniliselt sõnastab. Joonise allkiri 

reastatakse vasakult. Kõik joonised nummerdatakse analoogiliselt tabelitega. Joonise 

järjekorranumber kirjutatakse allkirja ette ja eraldatakse sellest punktiga, kusjuures sõna 

“Joonis” kirjutatakse välja täielikult ja trükitakse analoogiliselt tabeliga rasvases (Bold) kirjas.  

Näide: 

 

Joonisele kantavad tähised, arvud ja sõnaline tekst tuleb trükkida suurusega 11 punkti. Joonist 

kujundades tuleks silmas pidada, et seal olev informatsioon oleks selgesti eristatav ning 

jälgitav, milleks tuleb kasutada sobilikke erinevaid tähistusviise, kuid ei soovitata kasutada 

taustavärve. 

 

 

 Analoogiliselt tabeliga tuleb joonise juures näidata vastav allikas või märkida, et joonis on 

autori koostatud.. 

Joonisele kantavad tähised, arvud ja sõnaline tekst peavad olema selged ja loetavad.  

 

Värviprinteri puudumisel tuleks veenduda, et arvutis värviliselt nähtav 

joonis must-valges trükivariandis oleks piisava eristumistasemega. 

Joonis 1.2. Puidukasutus Eestis aastal 1930 

Kõigile töö sisus esitatud joonistele peab tekstis viitama. 
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Väike joonis paigutatakse sobivasse kohta teksti vahele, suur viitele järgnevale eraldi 

leheküljele. Väikese joonise kõrvale pole vaja teksti mahutada. Kui joonis ei ole autori 

koostatud, tuleb viidata allikale. Joonisel kasutatud tähitusi peab selgitama kas joonise väljal 

või allkirjas. 

Näide: 

0

50

100

150

200

250

300

350

400

2004 2005 2006 2007 2008

banaanid

maasikad

ploomid

 

                   Joonis 1. Banaanide, maasikate ja ploomide arv (autori koostatud) 

Graafikutel, mis on saadud arvutuslikult või katseandmete põhjal, peab olema arvskaalaga 

teljestik, koordinaatvõrk, funktsiooni ja argumendi tähised ning nende mõõtühikute tähised, 

koordinaatide alguspunkti väärtused (sealhulgas ka “null”), joonte (kõverate) positsioon-

numbrid või nende erisugune kujundus. Telgede nimetused võib välja kirjutada ja paigutada 

võimaluse korral telje keskele rööpselt. Arvskaala numbrid, tähised ja mõõtühikud 

kirjutatakse ühte veergu või ritta väljapoole joonise koordinaatvõrku telje otsa lähedusse 

selliselt, et need ei ulatuks üle võrgu ala või telje otste (noolte) piiride. Telgede nimetuste või 

tähiste juures olevad vastavate suuruste mõõtühikud eraldatakse komaga (näit aeg, h). 

Eksperimentaalselt saadud sõltuvuse puhul peab graafikule kandma ka katseandmetena 

saadud punktid ja vastava (või maksimaalselt lähedase) funktsiooni graafiku (Trendline), mis 

on eelistatud punkte ühendavate sirgjoonte kogumile. 
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 Valemid. Valemid eraldatakse muust tekstist kirjavahemärkidega, mis vastavad üldistele 

eesti keele reeglitele. Kõik märgid, arvud ja tähed tuleb paigutada valemis korrektselt ning 

kooskõlas valemi sisuga. Valemi kirjatüüp on Times New Roman ja kirja suurus 12.  

Valemite vormistamisel tuleb kasutada valemiredaktorit. Valemite vormistamiseks Wordis 

tehakse järgmised valikud: Insert → Object → Create new → Microsoft Equation 3.0. Kogu 

töö ulatuses tuleb järgida valemite ühtset kirjutusviisi.  Vältida tuleb definitsioonide 

esitamist valemi kujul ja valemite esitamist tekstina. Üksikud sümbolid ja lihtsad 

matemaatilised avaldised esitatakse reeglina teksti sees omaette reale viimata. Võrdust ja 

võrratust väljendavad avaldised esitatakse tavaliselt omaette real. Kui töös on mitu valemit, 

tuleb need nummerdada. Valemi number paigutatakse valemiga samale reale (soovitatavalt 

vasakule) sulgudesse.  

 

 

 

Valemi sümbolite seletus algab sõnaga “kus” (ilma järgneva koolonita) ning seletused 

kirjutatakse ülevaatlikkuse mõttes üksteise alla. Igas uues valemis selgitatakse ainult esma-

kordselt esinevaid tähistusi. 

Näide:

 

Kõik õppurite töödes esitatud tabelid ja joonised peavad vastama vormistamise 

nõuetele, seda ka juhul, kui nende algne loomine toimus väljaspool Word-i 

keskkonda. 

Valemites ei tooda mõõtühikuid, need esitatakse valemites kasutatud sümbolite 

seletustes. 

 
Kaalutud keskmine arvutati järgmise valemiga: 

321

332211

nnn

xnxnxn
x

++

++
= , (2) 

kus x - kaalutud keskmine, 
n1 - antud valimi rühma liikmete arv, 
x1 - antud rühma aritmeetiline keskmine. 
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Loetelud. Kui loetelu koosneb üksikutest sõnadest või lühikestest fraasidest, kirjutatakse 

loetelu punktid üksteise järele ja eraldatakse komaga. 

 

Järjekorda tähistatakse ümarsulgudega varustatud numbrite või tähtedega. Kui loetelu 

punktideks on üksikud laused, siis võib need kirjutada üksteise järele või alustada iga lauset 

uuelt realt. Numbri või tähe järel on ümarsulg, alustatakse väiketähega ja laused eraldatakse 

üksteisest semikooloniga. 

Näide: 

 

 

 

 

 

Kui kasvõi üks loetelu punktidest koosneb kahest või enamast lausest, siis asendatakse sulg 

järjekorranumbri järel punktiga. Kui mõni loetelu punkt sisaldab omakorda loetelu, siis 

tähistatakse üldisema loetelu punktide järjekorda tingimata numbritega, alluva loetelu punkte 

aga tähtedega (koos suluga). 

Näide: 

 

 

 

 

 

Kui kasvõi üks loetelu punktidest sisaldab koma(sid) või muid 

kirjavahemärke, tuleb eraldusmärgina kasutada semikoolonit. 

Turismi- ja hotellierialasid õpetatakse Eestis ligi 15 õppeasutuses. Turismialase 

kõrghariduse saab omandada kahe ülikooli kolledžis ja ühes erakõrgkoolis. 

Koolide suuremad probleemid on järgmised: 

• õppekavaga sobiva ja eestikeelse õppematerjali vähesus; 

• turismiettevõtluse taustaga ja pädevate koolitajate puudus; 

• õpetatava mittevastavus tegelikule tööturu vajadusele, mille üks põhjus on 

tööandjate vähene motiveeritus osaleda õppetöö ja praktika läbiviimises. 

 

Kaldaru (1997: 11– 12) hinnangul mõistetakse teooria all definitsioonide, eelduste ja 

hüpoteeside süsteemi. Teooriaid võib jaotada järgmiselt:  

1. Klassifitseerivad teooriad selgitavad majanduslikke realiteete mõistete defineerimise 

kaudu. 

2. Nomoloogilised teooriad on suunatud protsesside sisemiste seaduspärasuste avastamisele. 

3. Otsustusteooriad käsitlevad teatud inimkäitumise viise. Sealjuures võib neid jagada: 

a) deskriptiivseteks, 

b) preskriptiivseteks. 
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Muudel juhtudel võib järjekorra tähistuse (numbrid või tähed) ära jätta või esitada muu 

tähistusega. 

Näide: 

 

 

 

 

 

 

Tuleb silmas pidada, et erinevalt vormistatud loetelud annavad edasi erinevat sisu ning et 

kirjavahemärgid ei oleks vastuolus eesti keele grammatika reeglitega. Loetelu igal tasandil 

peab olema vähemalt kaks alapunkti. 

 

 

Lisadesse tuleb paigutada need arvandmed ja muud materjalid, mis on vajalikud probleemi 

käsitlemiseks, kuid mille esitamiseks tekstis pole otsest vajadust või kui on tegemist väga 

mahuka materjaliga. Lisad nummerdatakse neile viitamise järjekorras araabia numbritega, 

märkides analoogiliselt tabelite vormistamisele lehekülje vasakusse serva rasvases kirjas 

mitmes lisa on (näiteks “Lisa 7.” ning sellele järgneb lisa pealkiri. Kui lisa läheb mitmele 

leheküljele, siis tuleb järgneva(te)le märkida näiteks “Lisa 7 järg”. Lisad ja nende pealkirjad 

tuuakse ära sisukorras. Kõikidele lisadele tuleb töös kindlasti viidata. Tuleb vältida töö 

tekstiga nõrgalt seotud lisade esitamist. Lisades olevaid tabeleid ja jooniseid ei tule eraldi 

Loetelus kasutatakse nummerdamist tavaliselt siis, kui on oluline nende 

järjekord või arv, kui tekstis mõnele neist viidatakse või kui loetelu punktid 

koosnevad mitmest lausest. 

Väljatrüki eelvaatamiseks tuleb teha järgmist. 

1. Klõpsutage nupul Print Preview. 

2. Viige hiirekursor lehekülje kujutisele, kus see muutub suurendusklaasiks, 

ja klõpsutage hiire nuppu, mis suurendab kuva. 

Kuva suurendamiseks võib kasutada ka nuppu Zoom. 

3. Klõpsutage veelkord, mis kuvab uuesti kogu lehekülje. 

4. Väljatrükiks klõpsutage nupul Print, akna sulgemiseks nupul 

Kogu töö ulatuses tuleks kasutada ühtset loetelude esitust ning vältida 

paljude erinevate stiilide kasutamist. 
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nummerdada, iga lisasse paigutatav joonis või tabel võiks moodustada omaette lisa, ühele 

leheküljele võib paigutada mitu väiksemahulist lisa.  

 

 

 

Lisad koos pealkirjadega kirjutatakse ka sisukorda. 

3.4. Graafilised lisad ja nende vormistamine 

Graafilisteks lisadeks loetakse lõputöö juurde kuuluvaid jooniseid, mida töösse ei köideta. 

Sisukorras peavad nad kirjas olema.  

Igas ainevaldkonnas on graafiliste lisade vormistamisel omad iseärasused ja erinõuded, ent 

üldised alused ja põhimõtted on kõigil ühised. Graafilised lisad vormistatakse kindlas 

suuruses paberile (formaadid A0, A1 või A2). Nad võivad olla ka formaadis A3 või A4, kuid 

siis köidetakse nad käsikirja lõppu (eriti siis, kui suuremas formaadis jooniseid ei ole.  

Jooniste esteetiliselt vastuvõetav ja ökonoomne kujundus eeldab, et paberi pinnast oleks 

kujutiste, mõõtmete ja teksti näol esitatava informatsiooniga hõlmatud umbes 60 %. Joonised 

tehakse paberilehtedele, mille kõrguse ja laiuse vahekord ehk formaat on kindlaks määratud 

standardiga ISO 5457. 

Formaate kasutatakse horisontaalsena või vertikaalsena. Igal joonisel on raamjooned, 

kirjanurk ja köiteriba. Vajaduse korral võivad joonisel olla ka tsentreerimismärgid ning 

orientatsioonimärgid.  

Raamjoon tõmmatakse vähemalt 0,5 mm paksuse pideva jämejoonega. Selle kaugus for-

maatilõigatud paberi servast on formaatidel A4, A3 ja A2 vähemalt 10 mm, kuid formaati-del 

A1 ja A0 on see kaugus vähemalt 20 mm. 

Kirjanurk asub joonise alumises parempoolses nurgas, toetudes pikema küljega vastu 

alumist ja lühemaga vastu paremat raamjoont. Standardid annavad kirjanurga koostamiseks 

vaid üldisi põhimõtteid ja soovitusi. 

Töö koostamisel kasutatud küsitlusleht (täielik ankeet) tuleb esitada töö lisas 

ning kui selle juures kasutatakse (hindamis)skaalasid, siis tuleb nii ankeedis kui 

selle alusel koostatud jooniste ja tabelite juures esitada skaala selgitus. 
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Kui dokument on mitmel lehel, tuleb neist esimesele kirjutada lisaks lehe numbrile kald-

kriipsu järele ka lehtede üldarv, näiteks 1/6. Järglehtedele dokumendi lehtede üldarvu enam ei 

märgita. Kui joonis asub ainult ühel lehel, kirjutatakse lahtrisse “Leht” arv 1.  

Eseme ja sellest joonisel tehtud kujutise suuruse vahekorda selgitab mõõtkava ehk mastaap. 

Mõõtkava numbriliseks väljenduseks on mõõtsuhe. Standard ISO 5455 määrab kindlaks 

järgmised mõõtsuhted:  

� suurenduse korral − 2:1; 5:1; 10:1; 20:1 ja 50:1;  

� vähenduse korral – 1:2; 1:5; 1:10; 1:20; 1:50; 1:100; 1:200; 1:500; 1:1000; 1:2000; 

1:5000; 1:10 000.  

Vastavalt objekti suurusele ja vajalikule mõõtkavale valitakse sobiv paberi formaat (joonis 

3.3). Väljaprindituna peab joonis olema hästi loetav ning samas kõik vajalikud lisaelemendid 

(mõõdujooned, telgjooned, tingmärgid, märkused jne) peavad mahtuma joonise raamjoonega 

piiritletud alale. See tähendab, et mõõtkava ja paberilehe mõõdud peavad olema sellised, et 

võrreldes paberilehega ei oleks objekti kujutis liiga väike (joonis 3.4) ega ka ülearu suur − 

sellisel juhul ei mahu osa vajalikke lisaelemente joonisele või jäävad need liiga serva 

lähedale. 

Joonte liigid on määratletud standardiga ISO 128:1982  

Joonte jämedus ja selle valik. Joonisel kasutatakse kahte jämeduse poolest erinevat joont – 

jämejoont ja peenjoont. Jäme ja peenjoone jämeduse suhe peab olema vähemalt 2:1. 

Joontejämeduste rida: 0,13; 0,18; 0,25; 0,35; 0,5; 0,7; 1; 1,4 ja 2 mm.  

Joonise tekst kirjutatakse nn normkirjas, kui seda tehakse käsitsi. Arvuti abil vormistamise 

korral peetakse normkirjale kõige enam vastavaks kirjatüüpi Arial. Kuna normkiri on kald-

kiri, tuleb ka arvutisse teksti sisestades kasutada kaldkirja (Italic). Kirja suuruseks loetakse 

suurtähtede kõrgust millimeetrites. Kehtestatud on järgmised kirja suurused: 2,5; 3,5; 5; 7; 10; 

14 ja 20 mm. Väiketähtede kõrgus ei tohi olla väiksem kui 2,5 mm. Seega saab kirja 

suurusega 2,5 mm kirjutada vaid suurtähtedega. 

Paralleeljoonte vaheline kaugus ei tohiks joonisel kunagi olla väiksem kui kahest kõrvuti-

olevast joonest jämedama joone kahekordne jämedus. On soovitatav, et see vahe ei oleks 

väiksem kui 0,7 mm.  

Peale väljatrükki on vähim peenjoone jämedus 0,13 mm ning jämejoonel 0,25 mm. 
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Jooniste kokkumurdmine. Suureformaadilisi jooniseid võib köitmise eel või mugavama 

säilitamise eesmärgil kokku murda. Kokkumurdmisel formaat volditakse kõigepealt 

vertikaalseks „lõõtsaks”, millel joonise kirjanurk on pealpool, ning järgnevalt murtakse 

tekkinud „lõõts” formaadi A4 kõrguseks. Voldiku alumise kihi laius koos köiteribaga on 297 

mm, pealmised kihid on kitsamad. Kirjanurgaga pealmise kihi laius on 190 mm. Joonise 

ülemine vasakpoolne nurk murtakse tagasi. 
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Lisad  

Lisa 1. Referaadi, kursuseprojekti, ainetöö, praktika aruande, 

kursusetöö tiitellehe näidis 

 

VÕRUMAA KUTSEHARIDUSKESKUS 

Turismi õppetool 

 

 

 

 

 

Karin Kask 

T08 

 

 

Turismimajanduse areng Ukrainas 

Referaat õppeaines „Turismimajanduse alused” 

 

Juhendaja õpetaja Luule Lipp 

 

 

 

 

 

Väimela 2009 
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Lisa 2. Lõputöö tiitellehe näidis  

VÕRUMAA KUTSEHARIDUSKESKUS 

Infotehnoloogia õppetool 

 

 

 

 

 

Mihkel Maasik 

 

Infojuhtimise probleemid Võru Noortekeskuses 

Lõputöö infotehnoloogia süsteemide erialal 

 

Juhendaja õpetaja Riina Randmaa 

 

 

 

 

Väimela 2009
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Lisa 2a. Lõputöö tiitellehe pöörde näidis  

 

 

Kinnitan, et koostasin lõputöö iseseisvalt. Kõigile töös kasutatud teiste autorite töödele ja 

andmeallikatele on viidatud.  

…………………………………………  
kuupäev /nimi / allkiri /  

 

Töö vastab kehtivatele nõuetele. 

Juhendaja:  

…………………………………………  
kuupäev /nimi / allkiri /  
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